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60 Ask Us
Freeze the Genie, run Ethernet through USB, 
customize the Finder, and stop dropping those 
@#$%-ing PCI Express card screws inside your 
case. You’re welcome.

62 Make a Font out of 
Your Own Handwriting
Have you always wished you could type 
with your own unique handwriting style? 
Now you can. by Niko Coucouvanis

features

how to
68 Trick Our Your Photos
Don’t let those Photo Booth users 
have all the fun—here’s how to use 
OS X’s Core Image fi lters to funkify 
your photos. 
by Niko Coucouvanis

70 Make an iPod Book Case
Hollow books aren’t just for contraband 
anymore. We show you how to build one to 
house your ’Pod. by Brian Moore

18 The Best 
Gets Better
Having trouble deciphering the specs 
thrown around at WWDC? Check out our 
in-depth analysis of the Mac Pro Quad 
Xeon and Mac OS 10.5 Leopard. 
by Niko Coucouvanis and Rik Myslewski

OCTOBER2006
NO.122•VOLUME11•ISSUE10
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in Seconds
We show you how to use iWeb to put together a slick 
Web site in no time fl at—and how to really spiff it up 
if you’ve got some time to tinker.
by Kris Fong

36 Sound Advice
This month’s Field Guide on digital audio will familiarize 
you with the sonic world beyond iTunes. by Elliot Smith
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LIGHTER LOAD
You can use the wireless 
Mighty Mouse with either one 

or two AA batteries; you’ll 
get longer life with a 
pair of batteries, but 
some people prefer 
using a lighter mouse. 
From Reviews, p47.

LOST KEYS
Can’t remember 
a password in 
Keychain, or 
your keychain 
appears to be corrupt or 
otherwise inaccessible? Your 
best bet is to delete your 
keychain and re-create it. 
From Get Info, p14.

WHERE AM I?
Control-click on an item 
in your Web browser’s 
Downloads window to fi nd 
out where the fi le lives on 
your Mac. Bonus: Command-
click any document or Finder 
window’s title bar icon to see 
the item’s fi le 
path. From Ask 
Us, p60.

SCREW SALVATION
Any time you need to get a 
screw into a particularly hard-
to-reach hole, like the ones on 
your Power Mac G5’s PCI-slot 
covers, stick the screw to the 
screwdriver with a bit of glue-
stick goo. From Ask Us, p60.

QUICK TIPS
FROM THIS MONTH’S ISSUE

09 Editors’ Page
The pundits predicted that Apple wouldn’t take a bite out of 
the PC market. The pundits were wrong.
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BONUS!

Put this MP3 
tune from the 
Gin Blossoms’ 
new album on 
your ’Pod and 
enjoy!

“Learning the 
Hard Way”

122

BONUS!
“Learning the 
Hard Way”

To Quake fans—and what hardcore Mac gamer 
isn’t?—the release of the Quake 4 demo is huge 
news. Unfortunately, the size of the demo is huge, 
too: over 530MB! But don’t start that hours-long 
download yet; just install the full demo from this 
month’s Disc. We also managed to stuff a few 
other goodies on the Disc, including a free MP3 of 
“Learning the Hard Way” from the Gin Blossoms’ 
new album, Major Lodge Victory.
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AUDIO & MUSIC 
Edirol R-09 Field Recorder

demo video
iFill 1.1.0 demo
Sound Studio 3.0.4 demo
 

FUN & GAMES 
Quake 4 demo
 

GRAPHICS & MULTIMEDIA 
Image Tricks 2.2 freeware
ScanFont 4.0 demo
TypeTool 2.0 demo
 

INTERNET & COMMUNICATION 
BumperCar 2.0.7 trial
OmniWeb 5.1.3 trial

MEDIA
Edirol R-09 Field Recorder

demo video
Gin Blossoms’ “Learning the 
  Hard Way” MP3 tune
TechRestore mini Madness 
  video
 

PRODUCTIVITY 
OmniGraffl e 4.1.1 trial
OmniOutliner 3.6 demo
 

UTILITIES 
DiskTracker 2.3.3 (Classic) 
  shareware
DiskTracker 2.3.3 (Mac OS X) 
  shareware

Proxi 1.2 demo
TechRestore mini Madness 

video

SPONSORS
BumperCar 2.0.7 trial
Edirol R-09 Field Recorder 
  demo video
iFill 1.1.0 demo
OmniGraffl e 4.1.1 trial
OmniOutliner 3.6 demo
OmniWeb 5.1.3 trial
Proxi 1.2 demo
Sound Studio 3.0.4 demo
TechRestore mini Madness 
  video

BumperCar trial
It’s a wild and woolly Web 
out there; this colorful 
kids’ browser makes 
avoiding the uglier parts 

bulletproof fun.

TypeTool demo
Check out our How To 
on page 62 and learn 
how to use TypeTool to 
make a font out 
of your own 
handwriting.

Quake 4 demo
Join a fi erce armada of 
Earth’s fi nest warriors as 
they’re sent to battle the 
barbaric alien race known 
as the Strogg.
barbaric alien race known 
as the Strogg.



09EDITORS’ PAGE

09October 2006

During his keynote speech for Apple’s 
Worldwide Developers Conference, 
before the announcement of the 
new Mac Pro and Mac OS 10.5 
Leopard (see “The Best Gets Better,” 
p18), Steve Jobs let loose a fl urry 
of impressive statistics: During the 
company’s last fi scal quarter, the 
157 Apple Stores hosted 17 million 
visitors, Apple sold 1.33 million Macs, 
and the MacBook and MacBook Pro 

garnered an impressive 12 percent share of the laptop market.
The most impressive statistic to my mind, however, was the 

startling news that a full 50 percent of people buying Macs at Apple 
Stores last quarter were new to the Mac.

It’s working. The switch has begun in earnest. 
There are dozens of reasons why our ranks are growing. To name 

a few: the elegance and ease of use of Mac OS X; our operating 
system’s comparative invulnerability to viruses, worms, and all the 
ad-, spy-, and other menacing malware that infect our unfortunate 
Windows-using brethren; the iPod’s so-called halo effect that 
seduces PC users into our relaxing world of “It just works”; the 
switch to Intel processors and the comforting familiarity it provides 
to Windows sufferers—not to mention the fact that Boot Camp 
allows them to bring their favorite apps along to their new world.

And then there’s Vista. Or, to be more accurate, then there isn’t
Vista. That rough beast has been slouching toward Redmond to 
be born for years now—and when Mr. Bill announced recently that 
there was just an 80 percent chance that it would be released in 
January of 2007 as planned, many observers (including yours truly) 
took that as a sign that there was actually a 100 percent chance 
that its release date would slip yet again.

So imagine this scenario: Leopard and Vista both ship next 
spring—and one of Leopard’s top-secret features turns out to 
be that it can run on Intel-based hardware not manufactured by 
Apple. Even if only a subset of Leopard’s gorgeous features will be 
available on non-Apple hardware, and even if Mac OS 10.5 will run 
on only high-end PCs, the battle for the world’s desktops will enter 
a new—and exciting—phase.

I can dream, can’t I?

  Enjoy,

The Switch Is On

All modesty aside, a number of Very Smart People work here at MacAddict—and next month we’re going to share the top 
tips, tricks, software, and secrets that our editors, artists, and technogeeks have discovered over the years. Your Mac is 
pretty smart, too, and we’ll let it tell you 10 powers it possesses that you may not know it has. We’ll fi ll you in on rarely used 
Internet capabilities, how to bend time with cool stop-motion and time-lapse video projects, some smart ways to use 
Apple’s Preview app, and how to monitor your house with a motion-sensitive Webcam. We’ll also review Apple’s brand-
spankin’ new Mac Pro, FileMaker Pro 8.5, Logitech’s NuLOOQ input device, Script Software’s ChatFX, and more.

comingsoon:November2006
Here’s what our editors are preparing for the next issue of MacAddict.

 

STAFF RANTS
Q. What most impressed you among Apple’s recent announcements?

Roman Loyola  SELF-INVOLVED
What most impressed you among Apple’s recent announcements?
I impressed myself when I was able to recognize some of 
Leopard’s new features in other operating systems and 
apps. For example, Spaces=Linux workspaces, Time 
Machine=Windows Volume Shadow Copy, and iChat’s 

backdrops=ChatFX. I’m soooo smart!

Mark Rosenthal  LAZYBONES
What most impressed you among Apple’s recent announcements?
Like never coming through on my yearly promise to fl oss, I 
never seem to back up my Mac. But now Time Machine will do 
this chore for me! And since it’s a “set it and forget it” feature, 
it should organize all my fi les, fi x my fonts, and locate that lost 

picture of my uncle Morris boogie-boarding...right? 

Niko Coucouvanis  REALITY DISTORTION FIELDER
What most impressed you among Apple’s recent announcements?
After seeing the superlative this and the ultimate that every 
time Steve delivers a keynote, it was nice to see that he didn’t 
sandbag us with fudged numbers in the Mac-Pro-versus-Dell-
Precision-690 price comparison. They do spec out just like he 

said, give or take a few bucks.

Elliot Smith  HERALD OF DESTINY
What most impressed you among Apple’s recent announcements?
The people rejoiced as Time Machine was announced. 
Unfortunately for the original tester, however, the developers 
of the future could not make it back in time to save him as he 
vanished in the realms of time forever. Some say you can catch 

glimpses of him in the massively frustrating conglomeration that is Spaces.

Peter Marshutz  WORKAHOLIC
What most impressed you among Apple’s recent announcements?
What really excites me about the next operating system 
is the new iChat backgrounds—they’ll make “working 
from home” really fun!

Susie Ochs  TRUE BELIEVER
What most impressed you among Apple’s recent announcements?
Lots of things are impressive about attending your fi rst 
Apple keynote, but I’ve got to give it up for the continental 
comedy stylings of Apple’s senior vice president of software 
engineering, Bertrand Serlet. Très bien!

Brian Moore  VIDEO CHAT EXTRAORDINAIRE
What most impressed you among Apple’s recent announcements?
Defi nitely the updates to iChat. With tabbed chat windows, 
desktop sharing, and blue-screen-like effects, I fi nally have 
enough reason to move back from Adium. Now all I need are 
friends with iSights...

Max  JUICY FRUIT
What most impressed you among Apple’s recent announcements?
The Mac Pro and Leopard are both highly impressive, but what 
moved me most was the well-stocked case of Odwalla juices 
offered free to all the attendees. All hail B Berrier! Mmmm...
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 I
t’s easy to get sucked into the 
hoopla surrounding Apple’s new 
Mac Pro, Xserve, and Mac OS 10.5 
(see “The Best Gets Better,” p18, for 
the complete lowdown), but what 

makes the keynote at Apple’s Worldwide 
Developers Conference different from 
the January Mac Expo keynote is that 
the audience contains mostly software 
developers. Thus, the WWDC keynote 
tends to focus on Mac products such as 
Mac OS X, tower workstations, and other 
things that appeal to the seriously geeky.

While many of the developers we 
spoke to found the new Leopard features 
interesting, the one announcement 
that made the developers’ day was 
the release of Xcode 3, Apple’s main 
tool for writing software. “In one way 
or another,” said Braxton Sherouse, a 
student and musician at the University of 
North Carolina–Greensboro who writes 

audio software, “everyone who develops 
software had to migrate to Xcode or start 
in Xcode. We’re bound to Xcode, even more 
so than any OS feature.” Xcode got a brief 
mention during Jobs’s keynote; a full Xcode 
session was available for developers only.

“I come [to WWDC] almost ever year, 
and the Xcode stuff is always big,” said 
Keith Kotchou, a software engineer for 
Bio-Rad who has the daunting task of 
writing Universal versions of the some 
of Bio-Rad’s in-house software. Kotchou 
usually uses Freescale’s CodeWarrior for 
software development instead of Xcode. 
“You get used to how fast CodeWarrior 
works, how fast it compiles. I’m looking 
forward to Xcode 3.”

Plenty of developers closely inspected 
the new Mac Pro. “It’s really nicely 
done,” said Mark Hepburn, a lecturer of 
software development at the University of 
Tasmania in Australia, about the Mac Pro.

Mac-hardware company Other World 
Computing (http://eshop.macsales.com) 
received its Mac Pro machines soon 
after the WWDC keynote. “Overall, we’re 
excited that Apple’s moving forward,” 
said Larry O’Connor, OWC’s founder 
and CEO, in a telephone interview. “The 
Mac Pro is in a sweet spot pricewise. It’s 
not like the old days where you paid a 
premium to run Mac hardware. You just 
couldn’t ask for more.”

But O’Connor did point out that 
anyone who buys a Mac Pro with ideas 
of adding on third-party RAM needs 
to be aware of the type of RAM they’re 
buying. “There’s going to be a lot of 
people buying the wrong memory,” 
said O’Connor, whose company sells 
the proper Mac Pro FB-DIMMs. The 
FB-DIMM memory Apple uses has a 
special heat profile requirement, which 
is different from that used in standard 

Apple unveiled lots of goodies at the 2006 WWDC, but the hardcore geeks were 
most excited about one little line Steve Jobs said during the show.

IT’S ABOUT  
THE DEVELOPERS

More than 4,000 people who are probably 
way smarter than anyone on page 9 
gathered in San Francisco to 
get the nitty-gritty 
about Apple’s 
upcoming 
operating-
system 
release.
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4slim device from slim 
devices
Transporter
$1,999
www.slimdevices.com
Available: September
Designed for audiophiles, this is a 
networkable digital-music player 
that can play Apple Lossless, 
MP3, Ogg Vorbis, and other audio 
formats—but not music from the 
iTunes Music Store. 

4Write it doWn 
Memoir	1.0
$15
www.vortimac.com
Available: Now
This notebook application can be 
used for note keeping, journals, and 
more. It can export files to formats 
including Word, RTF, and text, and it 
also features file encryption.

4range rover
HWRGM1A	Hi-Gain	Wireless-108G	
MIMO	Router
$99.99
www.hawkingtech.com
Available: Now
The wireless router uses Hawking 
Technology’s AMP Technology to 

extend its Wi-Fi range.

 NEW Stuff

Wider Wi-Fi.

Organize your thoughts.

If only Apple would let others license  
the FairPlay DRM.

FB-DIMMs that conform to 
the Joint Electron Device 
Engineering Council 
(JEDEC) specification (for 
more on the Mac Pro’s 
memory, read “RAM 
Revolution,” p18).

Time Machine, Apple’s new backup 
feature in Leopard, was also top-of-mind 
among the developers attending the 
keynote—its dramatic interface and easy 
usability left a big impression. Richard 
Stacpole, who writes software for 
Geotechnical Engineering in Australia, 
was in awe. “If I would’ve designed 
Time Machine,” said Stacpole, “I never 
would’ve made anything that looks like 
that. It’s fantastic.” 

iChat’s new backdrops feature, 
which allows you to insert different 
image and video backgrounds into 
your video iChat conferences, isn’t new 
to users of Script Software’s ChatFX 
($20, www.scriptsoftware.com), an app 
that does much of the same things as 
iChat Theater. Despite the possibility 
that ChatFX could follow the footsteps 
of Konfabulator and other apps with 
features that were eventually added to 

Mac OS X, Script Software 
is optimistic. “Apple’s 
attention on this area 
verifies and validates 
the usefulness of 
ChatFX to the future of 
video conferencing,” 

said the company on its blog. Script 
Software is also working on ChatFX for 
other instant-messaging applications.

One technology that Apple didn’t 
reveal as a Leopard feature is the ability 
to run an operating system natively 
within another OS. This feature, called 
virtualization, is currently provided by 
Parallels Desktop for Mac ($79.99, www 
.parallels.com). “Apple didn’t affect 
Parallels from functioning,” said Benjamin 
Rudolph, Parallels’ marketing manager, 
explaining that the company has used 
its software on the Leopard developer 
release without problems.

The Leopard features previewed at 
WWDC led to the other topic popular 
among developers: What else will be in 
Leopard? A redesigned Finder? Windows 
virtualization? Enhanced tab controls in 
windows? We can’t wait to find out in the 
spring of 2007. —Roman Loyola

Banners with jabs at 
Microsoft’s up-and-coming OS 
adorned the halls of WWDC.

  

While Apple was jabbing Microsoft all throughout the WWDC, Microsoft’s 
Macintosh Business Unit (Mac BU) made a few announcements of its own. Most 
notable: The Mac BU said in a released statement that it’s decided “not to move 
forward with a Universal version of Virtual PC at this time.” It also said that current 
users of Virtual PC will continue to receive product support, but did not state if or 
when support for Virtual PC will be discontinued.

In light of the development of Apple’s Boot Camp, Windows virtualization 
via Parallels Desktop for Mac ($79.99, www.parallels.com) and CodeWeavers’ 
CrossOver Mac (in development at press time, www.codeweavers.com), the 
writing has been on the wall for Virtual PC for some time. In fact, in its statement, 
Microsoft Mac BU said that it feels “confident that alternative solutions offered by 
Apple and other vendors, combined with a fully packaged retail copy of Windows, 
will satisfy [the need to run Windows on a Mac],” a sign that Virtual PC will cease 
to exist in the era of Intel-based Macs.

Microsoft Mac BU also announced that the code for Office for Mac has been 
completely transitioned into Apple’s Xcode development tool, and is on the way to 

being a set of Universal applications (a release date was not mentioned). 
Also, converters for the new Microsoft Office Open XML format (used in 
the new version of Office for Windows) will be available for free.

Other Microsoft Mac BU news includes the release of Messenger 
for Mac 6.0 as a Universal application; the development of a free, 

Universal version of Remote Desktop 
Connection; and the discontinuation of 
support for Visual Basic scripting.—RL

Bon Voyage, Virtual PC

It’s the end of the virtual 
road for Virtual PC.
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CBDA droolworthy
Sexy Stuff We Can’t Wait to Get Our Mitts On

DMega Megapixels
the H2D-39 ($29,995, www.hasselbladusa.com) has a 39-
megapixel sensor, and it can save files to compact flash cards or 

an external fireWire 800 hard drive, or can be used while 
tethered to your mac. the camera uses Hasselblad’s 

new raW file format, 3f raW (3fr), which uses the 
company’s Hb rgb color-profile system.

’Pod MixerD
gemini’s iTrax Mixing Console 

($229.95, www.geminidj.com) is 
an entry-level console that can 

play music from your ’Pod. It has 
a pair of line-in ports for use with 
other audio devices, composite-
video output, a user-replaceable 

crossfader, and more.
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The Mac OS X Keychain is a great time-saver, storing passwords and 
other login information for Safari, Mail, and other software. The Keychain 
is accessed and manipulated by many different applications, so it’s 
susceptible to a number of problems. Here’s how to fi x some common 
Keychain problems.

PASSWORD AMNESIA  Can’t remember a password in Keychain? Your 
best bet is to delete your keychain and re-create it. Here’s how you can 
delete a keychain. Keep in mind that this routine is also useful if your 
keychain appears to be corrupt or otherwise inaccessible.

1. Launch Keychain Access (/Applications/Utilities).
2. Click Show Keychains in the lower-left corner of the window.
3. Select the problematic keychain from the left-hand pane.
4. Click File and select Delete Keychain name of keychain.
5. Check all options for deletion and press OK.
6. Create a new keychain. Go to the File menu, select New, and select 
 New Keychain.
7. You can now make this keychain your default. Go to the File menu, 
 select Make Keychain name of keychain Default.

NO ENTRY  Sometimes Keychain doesn’t automatically enter your 
password in a fi eld. Here’s the fi x.

1. Launch Keychain Access.
2. In the Keychains window on the upper left, select the login keychain.
3. Go to the File menu and select Make Keychain login name Default.

NOT-SO-LIGHT 
READING
At 1,641 pages, Amit Singh’s Mac OS X 

Internals: A Systems Approach ($64.99, www
.aw-bc.com) is a book for the few, the proud, the 
geeky—the type of Mac addict who loves full 
immersion into the gnarly bits of our beloved OS. If 
that’s you, prepare for some heavy lifting: Singh’s 
well-written, info-fi lled tome weighs as much as, 
or more than, some Apple hardware.
—Michelle Victoria

Amit Singh’s Mac OS X Internals: 
5.6 pounds

     Airport Express: 
    1.25 pounds

Mac mini Core Duo: 
2.9 pounds

            13-inch MacBook: 5.2 pounds

15-inch 
MacBook Pro: 
5.6 pounds

Bathroom reader 
for the eternally 
constipated.

One thing prevents your photo of a favorite tourist attraction from being 
postcardesque—those darn people who wouldn’t get out of the way of your shot. 

If you’re a skilled Photoshopper, you can painstakingly remove people from your pics. 
Or you can use Tourist Remover, a feature of snapmania’s online photo storage and 
sharing service (free, www.snapmania.com). Tourist Remover takes a series of photos 
of the same location and creates a fi nal image of your desired landscape without the 
strangers who got in the way. 

Our results with Tourist Remover were mixed; often, distracting little artifacts 
remained, but other pics were passable. The time it took for Tourist Remover to do 
its work also varied, but the longest we ever waited was about 10 minutes. For the 
best results, snapmania recommends using three to 10 photos of the same location, 
avoiding crowds, using a tripod, and having the same lighting for each photo. 
Snapmania has a 100MB capacity limit per account and also offers other photo 
services such as prints, books, and more.—RL
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Our results with Tourist Remover are shown here. The last pic, with all the people removed 
from the foregound, was created using the fi rst three pics.

EMAIL WITHOUT 
YOUR MAC
T  hanks to a company wholesomely 

named Celery ($99 to $259, www 
.mycelery.com), your fax machine 
has new life, brought on by the same 
technology that caused the demise of 
the fax machine: email. Celery lets you 
send and receive email via fax machine. 
To send an email, you handwrite your 
note and feed it though the fax 
machine, and the recipient gets 
an email with the handwritten 
note attached as a graphics 
fi le. Bonus: Celery 
receives emails just 
as you would a 
regular fax.—MV 

Give your fax 
machine new life.

REMOVE PEOPLE FROM YOUR PICS

>>>>>>>>>>>>>>>>>>>>>>>>>>>>
Bug of the Month
HOW TO RESOLVE KEYCHAIN ISSUES
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shareware pick of the month

NewsFire www.newsfirex.com $18.99

Most of you don’t wait for tomorrow’s newspaper to get the latest news. You want your news now, via the Web. With NewsFire, you 
can be alerted to up-to-the-minute news, blogs, and podcasts from a single, simple app. Here’s how you can get started with 

NewsFire. Download it and try out its powerful search capabilities and iTunes integration.—Andrew Tokuda

iSweats ($20, www 
.isweats.net) isn’t the 
first iPod hoodie to hit the 
market, but we couldn’t 
ignore the fact that 50 
cents from each iSweats 
sale goes toward buying 
winter clothes for Lakota 
Sioux* kids in North 
Dakota—and it gets damn 
cold in North Dakota. 
iSweats fits all iPods 
except the nano and the 
shuffle.—MV

* The seven subtribes of the Lakota 
are the Blackfoot, Brulé, Hunkpapa, 
Miniconjou, Oglala, Sans Arcs, and 
Two Kettles—and no, we don’t know 
how to say Two Kettles in Lakota.

ipod case of the month

sUBmit YoUr case  Whether your iPod case is a custom-made one-off or mass 
produced, you can submit it for Case of the Month consideration—just send it to iPod Case 
of the Month, MacAddict, 4000 Shoreline Ct., Ste. 400, South San Francisco, CA 94080. 
Please note that we cannot return cases.

6  In this example, which is a video 
podcast, you have the option of 
downloading the movie to your Mac.

 NewsFire comes with a handful of RSS 
feeds at launch, and each shows the  
latest story in the left pane of NewsFire’s 
main interface.

2  Before you add your own favorites, 
clean up the view by going to NewsFire > 
Preferences, clicking on the Appearance 
tab, and selecting Feed List Appearance > 
Feed Name Only.

3  Let’s say you want to subscribe to  
a video podcast—and every decent 
podcast site has an RSS feed. In Safari, 
click on the blue RSS button to see the  
RSS feed address. 

4  Now drag the site’s icon to the Feed List.

5  In seconds, NewsFire will download 
the latest stories from the feed. Highlight 
the feed and you’ll see the title and some 
of the text in the Item List. Click the New 
button for the story you want to read.

Perfect for sweatin’ to the oldies.

  

Intel-Igence RepoRt
Intel recently held a gathering of media members, analysts, 

and special guests to unveil the successor to the Core Duo 
processor in today’s iMacs, ’Books, and Mac minis: the not 
too creatively named Core 2 Duo processor. “Not since Intel 
introduced the Pentium processor has the industry seen the 
heart of the computer reinvented like this,” said Intel CEO 
Paul Otellini in a press release. The presentations by Otellini 
and Intel Executive VP Sean Maloney lacked the true-believer 
revival atmosphere of a Steve Jobs keynote, but they sure 
were chock-full of numbers—big numbers. Here are a few of 
the stats bandied about at the event.—RL

291,000,000
The number of 

transistors on a 

Core 2 Duo processor

34,000,000  

Total square footage 

of Intel’s processor-

fabrication facilities

1,500,000,000
Total number of the 

world’s Internet users by 2008 

65  As in 65 nanometers 

(.000000065 meters)—the 

width of an individual Core 2 Duo 

transistor

7  The number of weeks 

Intel said it would take 

to ship the first 1 million 

Core 2 Duo processors

6  The number of chicken 

satay skewers eaten at the 

event by MacAddict editors



Why is everyone 
using iStock?

“iStock gives life to projects I just couldn’t have done with the traditional 
stock models. It’s more than an image collection: it’s an extraordinary 
community for artists and graphic designers.”  – Marc

Gorgeous royalty-free stock, all starting at $1
Join for free and see. iStockphoto.com

Marc Sublet,
D E S I G N E R

Design Firm: nostroom production
Client: Swissmovie
Application: Series of posters
Country: Switzerland
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   The new Mac Pro and 
              Mac OS 10.5 Leopard 
redefi ne personal computing.
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The Best 
Gets Better
Which would you prefer: a lightning-fast, easily customizable upgrade to 

the world’s best personal computer, or a feature-fi lled, eye-poppingly 
gorgeous upgrade to the world’s best operating system?

How about both?

MAC PRO  With the introduction of the Mac Pro Quad Xeon, Apple’s transition 
to Intel processors is complete. This elegantly designed successor to the now-
retired Power Mac G5 is powered by a pair of muscular dual-core Intel Xeon 5100 
processors and engineered to be easily upgradeable and as quiet as a mouse.

LEOPARD  Mac OS 10.4 Tiger is arguably the fi nest operating system ever 
devised—but why stop there? Its next iteration, Leopard, brings a slew of new 
features and capabilities that make it easier to use, better integrated within itself 
and with the rest of the world, and more capable of adapting to your own unique 
way of computing.

MacAddict’s editors sat down with Apple and Intel engineers, peppered them 
with questions, and returned with insights and information about how—and 
why—the best just got better. Read on.

by Niko Coucouvanis and Rik Myslewski
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As usual, Apple trumpets the latest version of the Mac OS X as the 
best OS the company has ever released. We’re inclined to believe 
that, based on what we’ve seen of the sixth feline: new, integrated 
versions of Mail and iCal; the magical Time Machine backup utility; 
iChat’s surprising new Screen Sharing (and delightful new effects 
and backdrops); Spotlight’s new Boolean support; a built-in, 

nonbeta version of Boot Camp; easy ways to make Dashboard 
widgets; a new, smooth speaking voice and Braille support 
(finally!); and even an incomprehensible eye-candy generator called 
Core Animation. Unless the “top secret” stuff that Apple hasn’t 
revealed yet turns out to be a full Windows makeover, Leopard will 
emerge as the king of the cats. At least until 10.6 slinks along.

As of press time, Apple hadn’t let Leopard fully out of the bag—so for now, there aren’t a whole lot of brand-new apps or technologies (Steve 
said he wanted to keep some things secret so that Redmond couldn’t copy them into its long-delayed Vista operating system). But if Time 
Machine, Spaces, and Core Animation are harbingers of things to come, we’re going to like Leopard. A lot.  

What Time Machine 
Does
n It gets you in the backup 

game—finally.

n It backs up all of your 
documents and system files 
to a volume.

n It keeps daily backups of 
every document and system 
file that you’ve told it ahead 
of time to back up.

n It lets you restore a file that 
you’ve previously changed 
or deleted.

 

What Time Machine 
Doesn’t Do
n It doesn’t save your butt 

automatically—you need to 
turn it on first.

n It doesn’t create a bootable 
backup volume—you need 
to restore files from a Time 
Machine backup to a healthy 
boot drive.

n It doesn’t create a snapshot 
of arcane driver settings à la 
Windows’ System Restore.

n It doesn’t keep a running 
history of every change you 
save in a document.

Core Animation
Expect this technology to inspire some truly 
amazing future apps.
This one’s fun to look at, but actually using it is in the realm of 
software developers and other savvy tinkerers. Like Apple’s 
other Core technologies (Image, Video, Audio, and Data), Core 
Animation is a set of prefab instructions that software developers 
can use to animate pretty much anything. Imagine, for example, 
a deck of playing cards, where each card is a graphical layer 
(think Photoshop layers) containing an image, running video clip, 

chunk of text, or other object. Now add a timeline and assign 
each card a beginning state, a goal state (which could be 

considered the end state, but a clever programmer can direct the 
layer so that its goal changes as the project progresses along 
its timeline), and perhaps a few keyframes in between to force 
specific changes in the action. In the right hands, the result can 
look like the recent TV ad for the iTunes Music Store, in which 
thousands of album covers cascade from the sky and coalesce 
into a cityscape. Confused? That’s because Core Animation isn’t 
a toy for end users—but we sure hope Apple tosses us a bone 
similar to the Core Image Fun House app, which lets us play with 
image effects without a lick of programming skills (if you’ve 
installed Tiger’s Developer Tools, you can find Core Image Fun 
House in /Developer/Applications/Graphics Tools).

Mac OS 10.5 Leopard
Leapin’ Leopard, Batman! The next version of Mac OS X will make Bill Gates weep.

New Stuff
Here’s a tantalizing taste of tempting technologies.

Time Machine
Steve said that only 4 percent of Mac users 
automate their backups. That’s about to change.
Clearly the star of the show, Time Machine is the automated 
backup utility that, apparently, 96 percent of Mac addicts need. 
But instead of the boring, ugly, utilitarian face you’d expect to 
see on a backup “solution,” Time Machine actually looks like 
a freakin’ time machine! Nine out of 10 MacAddict editors dig 
its into-the-cosmos timeline interface (it’s nearly a 3D desktop, 
thus illustrating another trick we hope to see in Leopard’s final 
interface). In fact, Time Machine looks so striking that it generates 
its own mini Reality Distortion Field just like its charismatic 
godfather Steve Jobs does in his keynotes. We plied Apple 
engineers with fine Jamaican rum to get the facts on Time Machine. 

Here’s the real-world scenario: When you plug a FireWire drive 
into your Mac, System Preferences opens to the new Time Machine 
pane and asks if you’d like to use the drive for backups. If you say 
yes, you’ll get to decide what you want to back up: your system 
files, documents, iTunes and other iLife content, and anything else 
that you specify (or maybe anything that you don’t un-specify—we 
haven’t seen the final configurator yet). Time Machine backs up 
your designated items every day at midnight (provided your Mac 

is turned on and the backup volume is mounted), but you can set 
your own schedule via System Preferences. When you need to 
restore a file, you slip into Time Machine’s cosmic interface and 
thumb back in time to find documents that you’ve overwritten or 
deleted. When your system or boot drive goes belly-up and you 
start fresh with a new Mac OS X installation, just connect your 
backup drive, and a new version of Setup Assistant will ask if 
you’d like to restore files from your Time Machined backup drive.

ACCESSiBiLiTy  
Leopard includes a nod to vision-impaired Mac addicts with a couple of new VoiceOver features. We’re thrilled to welcome Alex, a high-quality 
voice who has a taste for speed, to Apple’s lineup. In the WWDC demo, Alex sounded comprehensible even with his rate-of-speech slider pegged to 
the fastest setting. VoiceOver is now multilingual and can speak text in your localized language, including double-byte tongues from the Far East.
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Mac Pro
The successor to the Power Mac G5 has more than just Intel inside.
If you’re a true Mac addict, you’ve already memorized the 
specs of the new Mac Pro—you may already even have one 
purring away on your desk. For the record, though, here are the 
basics: Each Mac Pro is powered by two dual-core Xeon 5100 
processors (see “Hail the Mighty Xeon!”) running at 2.0GHz, 
2.33GHz, or 3.0GHz—your choice. The basic confi guration 
includes two 512MB FB-DIMMs of RAM (see “RAM Revolution”) 
and either a 160GB, 250GB, or 500GB hard drive; RAM maxes 
out at 16GB, and Apple offers you the chance to add up to three 
more 500GB drives (though you easily can add your own of 
different sizes, if you’d prefer). A 16x SuperDrive occupies one 
of the two optical-drive bays. One PCI Express slot is fi lled with 
the graphics card of your choice (see “Pick a Card,” p23), and 

the others accept PCI Express cards of up to 16 lanes—when 
you insert one, a handy utility helps you set their Express lane 
allocation. 

A plethora of ports awaits you, as well: two independent 
10/100/1000BASE-T Ethernet ports, fi ve USB 2.0 ports (two 
on the front, three on the back), two FireWire ports on the 
front and two more on the back (one 400 and one 800 in each 
location), and all the analog and optical audio-input and -output 
ports you’ve come to expect on a top-end Mac—including a 
headphone jack on the front.

OK, so that’s the stuff you already know—read on to learn 
what you didn’t already fi nd out by surfi ng the Web after the 
Mac Pro’s introduction on August 7.

Hail the Mighty Xeon!
Intel’s potent processor’s name sounds as heroic 
as its performance.
We predicted that Apple would use Intel’s Core 2 Duo (née 
Conroe) processor in the Mac Pro. We were wrong—and we’re 
glad we were. The Xeon 5100 is a superior chip, and we’re glad 
to welcome it into the family.

The Xeon 5100 (as well as the Core 2 Duo) is built upon Intel’s 
new Core microarchitecture. Compared to previous top-end Intel 
processors, this architecture introduces advantages such as:
MORE WORK PER CLOCK CYCLE  Take a three-lane freeway. Add 
a fourth lane. More cars can travel on that freeway, right? That 
essentially is what the Xeon offers: another lane for instructions 

to follow when working their 
way through the processor, 
thus increasing performance 
by 33 percent. In addition, the 
Xeon can combine some small 
instructions into one larger one, 
thus increasing effi ciency.

SMART POWER MANAGEMENT  The Xeon can turn whole 
chucks of itself on and off in an instant when those areas of 
the chip aren’t needed in that clock cycle, thus saving power 
and reducing heat. Remember, a clock cycle is measured in 
billionths of a second, so this chip is faster than Cool Papa Bell, 
who Satchel Paige claimed was so fast that he could turn off the 
light and be in bed before the room got dark.
A HUGE, VERSATILE CACHE  Each of the two dual-core Xeon 
5100s in the Mac Pro have a 4MB on-chip cache, thus increasing 
the possibility that the data the processor needs is right there 
on its own chip, and not resting in far-off system memory. The 
cache is dynamically allocated between the chip’s two cores—if 
one core needs more cache, it gets it. Also, if one core needs the 
results of the other core’s computations, they’ll be waiting there 
for it in the cache. How harmonious. 
POWERFUL MEDIA CAPABILITIES  Apple’s Velocity Engine 
(née AltiVec, née VMX) long held a comfortable lead over 
Intel’s media-processing implementation, fi rst known as 
MMX and then SSE. With the latest implementation in the 
Core microarchitecture, however, it appears that that lead will 
become a thing of the past: Intel has effectively doubled the 
power of its media engine. Look out.
HYPER-ZIPPY DATA-TRANSFER SPEEDS  The Xeon speaks to the 
rest of the Mac Pro through dual independent buses that run at 
1.33GHz each, with the capability of transferring data at a peak 
rate of 21GB per second. We’re sorry, but that’s just insane.

The orderly lower half of the 
Xeon 5100 is its mongo cache; 
the upper half is where all the 
work gets done.

RAM Revolution
It’s time to learn a new acronym: FB-DIMM.
The Mac Pro introduces a new kind of system RAM: the fully 
buffered dual-inline memory module, better known as an 
FB-DIMM. The reason for this switch—as well as the reason for 
practically every change in the Mac’s history—is performance.

Up until today, RAM has acted essentially like a dumb bucket 
that your Mac’s memory controller fi lls and empties through a 
boatload of parallel data channels. Unfortunately, 
parallel data channels have this annoying 
habit of being error prone, and the faster 
they’re pushed, the more errors they make. In 
addition, they require an inordinate amount 
of parallel copper traces in motherboards 

to pump their data. FB-DIMMs, on the other hand, are serial 
devices, which use a smart chip on the FB-DIMM itself (called 
the AMB, for advanced memory buffer—but you knew that…) to 
manage the fl ow of data to and from the memory controller over 
a much simpler pathway.

Now, at about this time you’re beginning to wonder, “Why 
on earth should I care about any of this?” There’s a one-word 

answer: heat. The AMB has a hell of a lot of 
work to do, so it gets hella hot. FB-DIMMs 
are therefore equipped with heat sinks, as 

are those other heat-spawners, processors. 

that your Mac’s memory controller fi lls and empties through a 
boatload of parallel data channels. Unfortunately, 

they’re pushed, the more errors they make. In 
addition, they require an inordinate amount 

answer: heat. The AMB has a hell of a lot of 

are those other heat-spawners, processors. 

Meet the latest and greatest memory 
architecture: fully buffered DIMMs.

October 2006 21



Leopard (continued)

We live in Mail, with regular excursions to iCal, iChat, and of course surfin’ Safari. So imagine our delight to find Mail 3.0, iCal 3.0, iChat 
4.0, and a new trick for creating Dashboard widgets by simply clipping out part of a Web page in Safari for Leopard. Yes, we asked a friendly 
Apple tech-type if Leopard would bring a new version of Safari. Yes, he scowled menacingly at us, and no, he didn’t answer the question.

iChat 4.0
Here’s looking at you—wherever you appear to be.
The new iChat shows off some of Leopard’s best eye candy, as 
well as some seriously handy technology. Starting with the fluff, 
you can use Core effects (à la Photo Booth) to mirror, distort, 
invert, twist, and tweak your outgoing image in a video chat. Not 
zany enough? You can also add a still or moving-video backdrop—
no green screen or video-editing expertise required. The visible 
glow around your silhouette makes it clear that you’re not actually 
trying to fool anyone, which makes it fun; just don’t expect to use 
it to fake your whereabouts via video chat. The coolest part is that 
all of the magic happens on your Mac, so your chat partner doesn’t 

need Leopard—or a Mac at all for that matter—just a video-chat 
app supporting AOL AIM, Jabber, or of course, .Mac.

Sending files has been our favorite iChat trick for a while 

(just drag a file onto a Buddy’s icon or into an active iChat window), 
and iChat 4.0 brings new ways to share. A new presentation mode 
called iChat Theater lets you show content from iChat-enabled apps 
(currently iPhoto and Keynote, and someday, we hope, iCal and 
others) remotely via iChat or AIM. And iChat’s new Screen Sharing 
mode lets you view and control someone else’s Mac—or vice 
versa—from across the office or, dare we say, from Timbuktu (that’s 
Timbuktu, a city in the African nation of Mali, not Timbuktu, the 
commercial desktop-sharing software made by Netopia, a company 
that’s probably hating Apple right about now). We’re so jazzed on 
Screen Sharing that we’ll earnestly call it revolutionary for folks 
who collaborate creatively on digital projects. Short of attaching an 
extra keyboard and mouse to a Mac and crowding around a single 
display, this is huge for collaborative artists and anyone else who 
needs to share their screen.

Spaces
Create a place for everything and keep 
everything in its Space.
Mac OS X has always been the best multiuser OS in town, 
and Leopard’s Spaces let you fully express your own multiple 
personalities. The concept isn’t new—Unix and other OSes allow 
users to create virtual desktops. (Yes, Poindexter, we know that 
any computerized desktop is virtual, 
but we’re not here to split hairs.) 
More interesting than Spaces’ ability 
to group open apps into background 
subdesktops is the graphic-overlay 
control display, in which you can 
select the Space you want and even 
drag apps from Space to Space. We’ll 
go out on a limb here and extrapolate 
(with absolutely no empirical basis 
or insider information) that Leopard’s 
Desktop will include more of this style 

of visual stuff to highlight what we want at any given moment. 
Spaces isn’t about performance; it’s purely for convenience. 

When you tuck an app or three into a Space and get to work on 
something in another Space, the hidden spaces and apps can 
remain active in the background—out of sight and out of your 
way. Remember, though, that if you get too many background 
processes going, your Mac may start to lag. Maybe that’s why 

Steve demonstrated Spaces with a 
four-space scenario, as pictured in 
the screenshot. Apparently we’ll be 
able to create as many Spaces as our 
schizophrenic selves demand. Sybil, 
eat your heart out.

Finally, we get dedicated  
desktops for emailing, Final Cut 
editing, podcast producing, iWeb 
wonking, and whatever else we 
create a Space for.

Point Releases
Not everything in Leopard is new; some of it’s merely improved—a lot.

Mail 3.0
Meet your new—and gorgeous—personal assistant.
Email has replaced snail mail as the most-used form of interhuman 
communication. With its awesome new note-to-self features, Mail 
3.0 might get us to stop talking to ourselves. Notes might even 
replace the time-honored tradition of sneaker-netting small files 
from Mac to Mac on a flash drive. In fact, you may already use 
the underlying trick: emailing important documents and notes 
from work to home, or vice versa. No shame; we all do it. Mail 3.0 
comes preconfigured with a special mailbox called Notes, which 
you can access from your .Mac account or from any Webmail 
client. Your Notes can accommodate anything that you can attach 
to a regular email message: images, PDFs, movies, whatever. 

Even in their dedicated mailbox, Notes are ignorable. If you 
sometimes need a little help in the motivational department, 

use To Dos instead. To Dos link directly to iCal, so you can set an 
alarm to nudge you into action. Further bridging the gap between 
intention and action, you can easily create To Dos from any Mail 
or Note message. What’s more, both Notes and To Dos share a 
system-wide database that third-party developers can also tap 
into for their own apps. Hopefully, either a third-party app or one 
of Leopard’s unannounced features will be some kind of excuse 
generator, because we’re running out.

If you like your email frilly with HTML styling, photos, graphics, 
and other superfluousness, Mail’s new stationery templates 
are for you. All you do is pick one (30 are included), drag in your 
own photos, movies, or what have you from the iLife-style media 
browser, and type in your compelling text. You can save your own 
customized templates, but you can only create new ones with 
HTML. Nope, you can’t create the templates in iWeb. 
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Mac Pro (continued)

Unfortunately, not all heat sinks are created equal.
The FB-DIMMs in the Mac Pro have unusually beefy heat 

sinks, and the riser cards that the FB-DIMMs sit on are 
positioned in the path of two fans that cool them and—you 
guessed it—the processors. You could buy non-Apple 
FB-DIMMs to beef up the total RAM in your new Mac Pro, but 
if those modules don’t have the same level of heat-sinkifi cation 
as do Apple’s FB-DIMMs, your Mac Pro may run hotter, causing 
either fan noise to increase or RAM to operate less effi ciently, 

thus slowing down your system. Or both. Or neither. It’s hard 
to predict.

Fortunately, Apple has worked with an industry standards 
group, JEDEC (www.jedec.org), to establish an FB-DIMM thermal 
standard; when memory vendors produce FB-DIMMs that are 
certifi ed to meet that standard, feel free to stock up your Mac 
Pro with non-Apple FB-DIMMs. If the FB-DIMMs you buy don’t 
meet that thermal specifi cation, however…well…you pays your 
money and you takes your chance. 

Pick a Card
Apple offers a choice of three graphics cards—
here’s how to decide which one is right for you.
The standard confi guration of the Mac Pro includes an nVidia 
GeForce 7300 GT graphics card with 256MB of RAM. It’s no barn-
burner, but it’s a perfectly serviceable card if your day-to-day 
work involves productivity apps, page-layout and design, even 
Photoshop and Final Cut Pro. It’s more than beefy enough to take 
anything that Mac OS X’s display-rendering engine, Quartz, can 
throw at it.

If, however, you’re a gamer who wants cinematic-quality 
rendering of such niceties as grass waving in a digital fi eld or 
hair standing up on a terrifi ed digital head, defi nitely pop the 
extra $350 for the ATI Radeon X1900 XT with 512MB 
of RAM. The advantages of this card are many and 
varied, but some of it is sheer muscle. For example, 
modern GPUs (graphics processing units) 
process pixels in parallel pipes—essentially 
lanes that move pixel data through the GPU. 
The GeForce 7300 GT has eight pipes; the 
Radeon X1900 XT has 16. Some of the processing 
of an image is performed by what are called pixel

(or texture) shaders and vertex shaders; unfortunately, defi ning 
exactly what they do would take the next couple of pages, 
but if you’re interested, www.wikipedia.org has a pleasantly 
understandable explanation. The important thing to remember is 
that, as with pipes—and all else being equal—the more shaders, 
the merrier. The GeForce 7300 GT has eight pixel shaders and 
four vertex shaders; the Radeon X1900 XT has 48 of the former 
and eight of the latter. If you’re pushing pixels in InDesign, you 
won’t notice the difference, but if your day frequently involves 
descents into hell in Doom 3, pick the Radeon X1900 XT.

Oh, and then there’s the workstation-class nVidia 
Quadro FX 4500 with 512MB of RAM and 

Stereo 3D performance. Skip this 
$1,650 upgrade unless your work 

involves CAD, real-time 3D scientifi c 
modeling, or high-end 3D animation and 

compositing. Simply put, if you don’t already 
know the specs and capabilities of the Quadro 

FX 4500, you don’t need the Quadro FX 4500.

Hey, gamer! Here’s the card to order with your Mac 
Pro: the ATI Radeon X1900 XT.

1  Two optical-drive bays, one with a 
16x SuperDrive and one that you can 
either order with another SuperDrive 
from Apple or fi ll with your own 
choice of optical drive, such as a fast 
CD-R drive.
2  Auto-switching power supply: 

either 100-120V AC or 200-240V AC.
3  Four slide-out hard-drive trays. 

You can order your Mac Pro with 
a single 160GB, 250GB, or 500GB 
7,200 rpm drive, or have Apple add 
up to three more 500GB drives. 
Alternatively, you can fi ll the extra 
three drive trays yourself with your 
own choice of SATA drives.

4  Two fans cool the already 
reasonably cool processors, 
PCI Express cars, and 
memory.
5  Here’s where the Xeon 

5100 processors live; you 
choose whether you want 
2.0GHz, 2.66GHz, or 3.0GHz 
chips. Also on board: Intel’s 
Greencrest northbridge and 
ESB2 southbridge.

6  Four PCI Express slots 
are available; one is a double-
wide slot that allows the 
installation of a PCI graphics 
card that would otherwise 
cover its adjacent slot.
7  Two FB-DIMM riser cards 

allow you to install up to 
16GB of system memory.

Inside Stuff
Although the Mac Pro 
looks nearly identical to 
the Power Mac G5 on the 
outside, on the inside 
it’s a different story 
altogether.
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If, however, you’re a gamer who wants cinematic-quality 
rendering of such niceties as grass waving in a digital fi eld or 
hair standing up on a terrifi ed digital head, defi nitely pop the 
extra $350 for the ATI Radeon X1900 XT with 512MB 
of RAM. The advantages of this card are many and 
varied, but some of it is sheer muscle. For example, 

Radeon X1900 XT has 16. Some of the processing 
pixel

Oh, and then there’s the workstation-class nVidia 
Quadro FX 4500 with 512MB of RAM and 

Stereo 3D performance. Skip this 
$1,650 upgrade unless your work 

involves CAD, real-time 3D scientifi c 
modeling, or high-end 3D animation and 

compositing. Simply put, if you don’t already 
know the specs and capabilities of the Quadro 

FX 4500, you don’t need the Quadro FX 4500.

Hey, gamer! Here’s the card to order with your Mac 
Pro: the ATI Radeon X1900 XT.
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Leopard (continued)

Spotlight 
Apple searched for Spotlight improvements and 
found a few important ones.
We suspect (and hope) that Spotlight is still waiting for its 
share of Leopard’s yet-unannounced top-secret improvements, 
because the tweaked Spotlight that Apple is currently showing 
off still seems incomplete. We welcome improvements like 
support for Boolean operators such as And, Not, and Or to fine-
tune your search, as well as the addition of search criteria (such 
as Size, Kind, Date Modified, and so on) that we currently get 
only in Finder (Command-F) searches.

Spotlight for Leopard uses the same metadata-indexing mojo 
to keep tabs on your files, but uses a different tactic to winnow 
your query. The new Spotlight filters the index, removing items 
that don’t match your criteria, which is generally more efficient 
than the old style of searching the index for things that do match.

When the new Spotlight completes your search, you’ll see the 

real magic. The new Quick Look feature provides an instant, one-
click preview of the document as a graphical screen overlay—we 
didn’t see it in action, but we suspect it comes with some 
splashy eye candy. Quick Look will show the contents of text 
documents, PDFs, photos, Address Book contacts—probably 
anything that the Finder can preview and then some. Speaking 
of which, we hope to see this technology in some of Leopard’s 
as-yet-unannounced improvements—such as the Finder.

If your digital life is scattered across multiple Macs, Spotlight 
can now traverse the network in search of your files. On a small 
scale, such as a two- or five-Mac household, all you need to do 
is enable Spotlight and file sharing on all the Macs and have at 
it. Each Mac maintains its own Spotlight index, so you can easily 
search on every Tiger- or Leopard-running Mac on the home 
network. If you’re on a bigger network running Mac OS X Leopard 
Server, you can search that server just as effortlessly, thanks to 
the new Spotlight Server.

Dashboard
Don’t like any of the 2,500-plus widgets now 
available? Make one of your own! 
When was the last time you tapped F12 to summon Dashboard 
and your army of flying monkeys—er, widgets? We bet it was 
either two minutes ago or not since the initial widget novelty 
wore off about six days after you upgraded to Tiger. Love it or 
hate it, Dashboard can potentially save you boatloads of time 
and mouse clickery, but only if you can find a widget that does 
exactly what you need done—or if you can make that widget 
yourself. Starting with Leopard, plan B—making your own 

widgets—looks to be almost as easy as using widgets. 
In fact, Leopard brings two ways to build your own 

widgets—we’ll start with Dashcode. Although Apple isn’t 
showing its interface to the public yet, Dashcode looks to be 
one of the stars of Leopard—not specifically for the amazing 
widgets it’ll help spawn as much as for the tool itself. Apple 
claims Dashcode includes a full JavaScript debugger (this 
revelation sent the geeks at the WWDC keynote announcement 
into a veritable frenzy) and a visual WYSIWYG (what you 
see is what you get) environment for assembling the widget 
graphically, using precoded components such as the standard 
widget-close box and Info-pane flipper, search fields, buttons, 
bars, boxes, and other goodies. If you’ve ever tried making your 
own widgets, you know how big a deal this is.

If Dashcode sounds like more effort than you’re willing to 

iCal 3.0
Gain even more control over your schedule—and 
your colleagues’.
At version 3.0, our little calendar is all grown up and supporting 
fancy-pants open-source standards such as CalDAV. If you 
don’t know your acronyms, DAV is distributed authoring and 
versioning—your ticket to real shared calendars. No .Mac account 
or iCal Server (see “Leopard Server? We Barely Know ’Er!” p25)? 
No problem. You can host your group iCal on the home or company 
network, or on most ISP-hosted accounts, according to Apple reps. 

Add Mail integration to iCal’s multiuser-friendliness, and you 
get cool features such as automatic email notifications for all of 

an event or meeting’s attendees—and since you share an iCal 
calendar, you’ll already know when everybody’s free for that 
important meeting. 

If you’ve prepared a presentation for group members, 
distributing the materials is as easy as dropping files—such  
as Address Book contacts, documents, image files, and even  
video—onto the event in iCal, from where your colleagues can 
download and peruse them at their convenience. We’re surprised 
that Apple didn’t integrate iChat with iCal to enable onboard 
face-to-face time for quick confirmations, pre-meeting briefing 
sessions, or what have you—maybe that’ll appear as one of the 
top-secret features.

Finally Fixed
Stymied by Spotlight? Less than dazzled by Dashboard? Leopard can help.
After rocking Tiger for over a year, we’ve got to admit that parts of it make us go all sourpuss—namely Spotlight for its general lack of 
intuitiveness, Dashboard for the lack of any help creating our own widgets, and Automator for refusing to bend to our specific whims. 
Leopard cures two of the current cat’s woes with greatly improved versions of Spotlight and Dashboard—and we can only hope that 
Automator 2.0 shows its shiny metal butt in Leopard.

SySteM RequiReMentS
Leopard is a true 64-bit operating system, fine-tuned for the screamin’-fast Intel processors in the new Mac Pro—so what of our yelling-really-loud-
fast Power Mac G5s? Leopard is also fine-tuned for the previous incarnation of pro Macs. And what of the once-mighty G3 and G4 Power Macs? 
Mum’s the official word, but we’re guessing no—full system requirements won’t be announced until Leopard ships. 

   October 200624



waste on widgets, there’s another way: Web Clip. Safari 
for Leopard (again, we asked Apple reps about a new 
version of Safari, but they wouldn’t tell us anything) sports 
a new button: Open In Dashboard. Remember, widgets 
are essentially just mini Web pages, so opening a page 
as a widget isn’t so shocking. The shock comes when you 
discover how easy it is: You simply find the item on the 
page that you want to widgetize—a traffic camera, for 
example—then drag a selection box around that element, 
pick a theme from the drop-down theme browser, and 
bang, you’ve built a traffic-cam widget. What’s more, your 
new widget is a live, updating, interactive wonder.

What we don’t get is why Apple seems so proud of the 
fact that we’ll be able to sync our Dashboard preferences 
via a .Mac account for a consistent widget experience on 
any Mac. That sounds to us like a huge antifeature, so 
we’re counting on Apple to fill in the blanks with some  
of that unannounced, top-secret stuff relating to syncing 
and .Mac. n

Mac Pro (continued)

Leopard Server? We BareLy KnoW ’er!
As always, Mac OS X comes in two flavors: regular old Leopard 
for most of us, and Leopard Server for IT jockeys. Leopard Server 
boasts some powerful features that will help Apple become more of 
a player in the high-end enterprise space, where a secure, robust, 
multiuser system is a necessity—and easy setup is appreciated. 
Leopard’s Server Admin tools make administrating large networks 
push-button easy. Don’t believe it? Well, setting up a network using 
OS 10.4 Server’s Server Assistant, Server Admin, and Workgroup 
Manager is already child’s play—Leopard’s Automatic Client Setup 
feature will cover most of the pointing and clicking for you, blessing 
new users with the appropriate services that you’ve configured on 
the server, such as mail, print, iCal, and iChat. 

Leopard Server includes some completely new services that 
make Mac OS an even more viable choice for serious businesses. 
OS X’s (previous) lack of a collaborative groupware/scheduling 
app kept it out of many small-to-large businesses, but iCal Server 
changes that. It’s based on the open-source protocols that power 
the likes of Microsoft Outlook and Mozilla Sunbird. Like business, 
Mac OS X Server is all about collaboration, as evidenced by iCal 
Server and other two-heads-are-better-than-one services for 
group-writable wikis and blogs, an improved Xgrid clustering kit, 
a centralized Spotlight server, and tons more, including a secure 
iChat Server that can keep your sensitive company chat away from 
the public AIM servers.

Q&a
any more questions? Thought so…
Q. Apple only offers a second SuperDrive for the second 
optical-drive bay—does that mean I can’t put a fast CD-R drive 
in there instead? 
a. You’re free to pop whatever optical drive you want into that 
bay; it has a standard ATA/100 connector.

Q. If I order my Mac Pro without Bluetooth or AirPort and then 
decide later that I was an idiot and should have gotten them, 
can I install them, or am I just S.O.L.?
a. You can’t—they’re modules that go onto the motherboard—
but your local Apple Authorized Service Provider can.

Q. Do the FireWire ports on the front (one 400, one 800) and 
back (ditto) have to compete for bandwidth?
a. Nope. They each have their own dedicated FireWire 
controller.

Q.How about the USB ports (two on the front, three on  
the back)?
a. Ditto, ditto.

Q. While we’re talking USB, has the meager USB power supplied 
by the ports on the keyboard been increased?
a. Sorry; they’re still wimps.

Q. Do I need to install FB-DIMMs in pairs?
a. Yup, one in the top riser card and a matching one in the 
bottom card. Bonus: The riser cards have nifty little plastic 
spacers on their bottoms to prevent you from scratching your 
table when you add FB-DIMMs.

Q. How easy is it to install more internal hard drives?
a. All you need to do is slide out one of the four included hard-
drive drawers, screw your hard drive into it, and then slide the 
drawer back in—a process that could be accomplished by a  
dim-witted 8-year-old in a dinghy during a driving rainstorm 
in the dark. Oh, and you can use Disk Utility (/Applications/
Utilities) to create a smokin’ internal RAID 0 setup, should the 
spirit so move you.

Q. How many fans does this puppy have?
a. Four. The Power Mac G5 had up to nine (and the high-end 
models also had liquid cooling). On the Mac Pro, one of the fans 
cools the power supply; two direct air over the processor, PCI 
Express cards, and memory; and the last one’s in charge of the 
hard drives and optical drives.

Q. Intel’s specs say that the 3.0GHz Xeon draws more power 
than the 2.66GHz and 2.0GHz parts. Won’t it run hotter and 
cause more fan noise?
a. Apple assured us that the entire cooling system in the 
Mac Pro doesn’t experience as much of the “up engine, down 
engine” noise fluctuation as did the Power Mac G5, and that 
there isn’t “much difference” in fan noise among the models.

Q. I hear that the processors in the Mac Pro are socketed, not 
soldered to the motherboard like they are in every other Mac in 
recent years. Does this mean I can take out the processors and 
put in new ones?
a. Yes, you can—but if you do so, you’re on your own. Apple 
doesn’t support processor swapping.

no More Lost Screws
Have you ever wrestled with the PCI-card lock-down screws in a Power Mac G5? Or, even 
worse, dropped one deep down into the PCI Screw Graveyard, only to never find it again? 
That annoyance is over. In the Mac Pro, all PCI Express cards (up to four) are held in place 
by a single bracket. Those thumbscrews? They’re rigged so that they won’t fall out of the 
bracket. Nice.

Thanks, Apple—you’re always thinking of us.

Niko Coucouvanis and Rik Myslewski have been in the Mac-publishing biz for 27 years combined—
and they’ve never had enough pages to fully explain any of Apple’s announcements during that time.

October 2006      25



Left Right

Left Right



Left Right

Left Right



   October 200628

>> Select a Style. 
Open iWeb and choose File > New 
Site to view the template styles. 
Select any template in the left 
column to see the page designs 
(each template includes Welcome, 

U nless you design Web sites for a living, chances are you’ve haplessly 
wrestled with your ISP’s meager Web-template offerings to kludge 
together a snapshot of your life—in pixel form—and share it with the 
world. But why allow your Web site to wallow in boring or ugly page 

design when you have a snazzy virtual Web designer at your disposal? Meet iWeb, 
the youngest sibling in Apple’s iLife ’06 family ($79, www.apple.com).

iWeb includes fully editable templates that allow you to quickly and easily 
create slick-looking Web sites whether you don’t want to fuss with details or 
you want to create a site as unique as yourself. You can create general sites 
that showcase your endeavors, travels, photos, and other interests, or use the 
specialized templates to house your blog, podcasts, movies, and other media. And 
the best thing: You don’t need to know one bit of code to build a complex site.

If you’re looking to get something up fast, we’ll show you how to build a site in 
seconds and publish pages to .Mac or other Web servers. And if your creativity 
knows no bounds, we’ve got tons of ways to tweak pages to your design delight.

About Me, Photos, Movie, Blog, 
Podcast, and Blank page layouts). 
Then select a page type (such as 
the Welcome page, for starters) 
and click Choose to create your 
Web site’s foundation.

Build a Site in Seconds
Using iWeb’s templates, you can literally create a site in seconds—well, maybe 600 seconds, depending on how wordy you tend to 

be and the level of your typing skills (or lack thereof). If you want something fast without the fuss, use this approach.

Generate fully 
designed pages 
in as few as two 
clicks, thanks 
to iWeb’s prefab 
templates.

To add more pages, choose 
File > New Page and choose 
another page type. Repeat as 
desired. iWeb automatically adds 
a navigation menu to your pages, 
and lists all pages in the Site 
Organizer. Your site’s home page 
(the one to which all other pages 
are linked) is listed on top. To 
change your home page, drag any 
page to the top location and iWeb 
will reorder the menu accordingly.

>> PerSonalize 
PageS. Just about everything 
on any page can be modified. If 
simplicity is what you’re after, 
here’s how to personalize pages 
pronto; just select any page in the 

>> Create Sites  
in Seconds
Whether you’re lazy or ambitious, iWeb makes 
creating your own Web site speedy and pain-free.
 by Kris Fong



October 2006      29

Site Organizer  
to begin.

>> ExchangE a FEw words. 
Every page type (except for Blank) 
bears some placeholder gibberish 
text that you’ll want to replace, 
unless you prefer your pages to 
speak in tongues. To change text 
(other than the navigation-menu 
text—we’ll show you how to do 
that in a bit), double-click the text 
to highlight it and type away.

>> PlacE Your Pics. To swap 
out placeholder images with 
your own, drag and drop a photo 
directly onto a placeholder on 
any page—iWeb automatically 
resizes your pic to fit the design. 
To add images from iPhoto, click 
Media to open the Media Browser, 
select Photos, and then drag any 
thumbnail onto a placeholder.

To create a blog, 
type entries in the 
Entries page; iWeb 
automatically uses 
the info to build your 
blog’s main page  
and archive.

Add pics by simply 
dragging and 
dropping photos from 
the Finder or Media 
Browser.

>> add MEdia. If you created a 
Movie page, select it in the Site 
Organizer and then drag and 
drop a movie file directly onto the 
placeholder. To add a movie from 
iMovie, click Media to open the 
Media Browser, select Movies, 
and then drag any clip onto the 
placeholder. 

If you created a Podcast page, 
select its Entries page in the Site 
Organizer and then drag a podcast 
file (audio or video) onto the 
placeholder. Or grab your podcast 
from iTunes by opening the Media 

Browser, selecting 
Audio, and dragging 
in a file. Got more 
than one podcast? 
Click Add Entry to 
add another—iWeb 
automatically adds 
a Subscribe button 
and lists all podcast 
entries on the 
Archive page.

>> Broadcast 
Your Blog. Like 
Podcast pages, 

Blog pages consist of an Entries 
page, which holds your individual 
ramblings, and an Archive page 
that lists them all. If you’ve created 
a Blog page, select its Entries page 
and then replace the placeholder 
text with your own musings. To 
add another entry, click Add 
Entry. iWeb automatically adds a 
Subscribe button and logs each 
entry on the Archive page.

>> hello, inspector.
The Inspector allows you to modify 
content and elements in your site. 
You can use it to password-protect 
pages, enable blog features, 
set parameters, control text and 
image behavior, create hyperlinks, 
and more. The content in each 
Inspector window will change 
according to the object you’ve 

In under a minute, we created a 
decent enough Welcome page 
(below) using iWeb’s Road Trip 
template—but with a little extra 
time and elbow grease, we made it 
far more visually interesting (left).

selected. Since we’re on the fast 
and furious plan, just address 
these things (we’ll revisit the 
Inspector in depth in “Make Your 
Sites Unique,” p31).

>> naMing rights. iWeb  
gives all new sites the uninspiring, 
but appropriate, name of “Site.” 
To change it, select any page 
in the Site Organizer and then 
click Inspector to open it. In the 
resulting window, click the globe 
icon to display the Site Inspector 
and then type a name for your site 
in the Site Name field.

>> MEnu ModiFication. You 
can’t edit navigation-menu text like 
you can other text. To change menu 
text (and thus the corresponding 
page title), select a page in the Site 
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Once you publish your site to either .Mac or a folder, you can comb through all 
source files that compose your site.

Publishing Pages
iWeb makes it easy to publish Web pages to .Mac or another Web-hosting server. Do note that pages 

published to .Mac benefit from the following features and options (we’ll show you how to bring some of these 

functions to non-.Mac-hosted pages in “Hacker’s Delight,” p32):

PasswOrd PrOtectiOn: Protects access to certain pages with a user name and password.
enhanced slide shOws: Displays slide shows in a window with added control and a reflection effect.
BlOg cOMMents: Allows visitors to post comments on your blog pages.
BlOg search: Adds search capabilities to your blog pages.
hit cOunter: Displays how many times a page has been viewed.

Tip
Don’t have a 
.Mac account 
or access to a 
Web-hosting 
server? Sign up 
for a free 60-day 
.Mac trial at 
www.mac 
.com to publish 
your pages. 
Of course, if 
your trial ends 
because you 
didn’t cough up 
the membership 
fee, so will your 
Web site.

Organizer, click the Inspector icon, 
click the page icon to display the 
Page Inspector, and type a name 
in the Page Name field. Repeat as 

If you have a Podcast page and 
want to publish your podcast to 
the iTunes Music Store, select  
the page, click Podcast in the  
Blog & Podcast Inspector, select 
the Allow Podcast In iTunes Music 
Store check box, and dole out  
your podcast’s details in the 
provided fields.

>> AdditionAl ElEmEnts. 
If you want visitors to send you 
email, add an Email Me button. 
Select a page in the Site Organizer 
and then choose Insert > Button >  
Email Me. To add a hit counter 
(this won’t display on non-.Mac-
published pages), select a page 
and then choose Insert > Button > 
Hit Counter.

>> Publishing to 
.Mac. In iWeb, select your 
site in the Site Organizer and 
click Publish. In the resulting 
dialog, click Publish All to have 
iWeb publish every page in 
your site—this may take a while 
depending on the size of your site 
and your Internet upload speed. If 
you’re using iWeb 1.1 or later, you 
can have iWeb only publish pages 
that you’ve changed in subsequent 
updates; click Publish and then 
click Publish Changes Only in the 
dialog that appears.

You and the rest of the world  
can find your site at http://web 
.mac.com/membername. If you 
publish more than one site to .Mac, 
your sites can be found at http://
web.mac.com/membername/
iWeb/sitename. You’ll find the 
source files on your iDisk in /Web/
Sites/iWeb.

when you rename a page, iweb updates the name in the 
navigation menu.

desired with your other pages.

>> BloggErs And 
PodcAstErs. If you plan to 
publish your site to .Mac and you 
have a Blog page, you can enable 
comments (which allows visitors 
to post feedback on your blog) 
and search capabilities. (These 
features are unavailable if you 
publish to a non-.Mac site, but 
we’ll show you a workaround in 
“Hacker’s Delight,” p32.) Select a 
Blog page, click the Inspector icon, 
and click the RSS icon to display 
the Blog & Podcast Inspector. Click 
Blog and then select the Allow 
Comments check box and the 
Display Search Field check box to 
enable these features. 

>> Publishing to a 
non–.Mac server.
In iWeb, choose File > Publish To 
A Folder. In the resulting dialog, 
navigate to and select a folder 
to store your site (or click New 
Folder to create new housing), 
type the URL for your Web site in 

the space provided (this enables 
iWeb to generate your blog’s RSS 
feed), and click Choose. iWeb puts 
all the files that make up your site 
into the folder, which you can then 
upload to your hosting server as 
you normally would, using your 
FTP app of choice.
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>> Trick OuT YOur 
TexT. Don’t feel limited by a 
page template’s text placement, 
font, color, size, or alignment—
everything’s fully customizable. 
Here’s a look at some of the 
things you can do.

>> Basic Moves and TexT 

Make Your Site Unique
If you really want to put your own stamp on an otherwise cookie-cutter site (though iWeb is, thankfully, more 

Mrs. Fields than Pillsbury), it’s time to get down to business and make it personal—your Web site, that is. 

Here’s how to put your own spin on your pages.

TreaTMenTs. To move a text 
block, click the text to highlight 
the text box and drag the box 
to your desired location. If you 
want to change a text block’s size 
(handy for creating text columns 
or changing the text flow), drag 
any point on the text box to resize 
it. Don’t like the font or type size? 

To make text go 
topsy-turvy, crank 
the Rotate dial 
in the Metrics 
Inspector.

We didn’t like the limitations of 
iWeb’s navigation menu, so we 
made our own using the Link 
Inspector to hyperlink pics to pages.

>> Make oBjecTs Glow.
The method for creating 
shadows (“Eye Candy,” p33) 
can also make things glow. 
Just select a light color in the 
Shadows color swatch and 
adjust the Offset, Blur, and 
Opacity variables to make the 
effect luminous.

>> Build PicTure PaGes 
FasT. You can easily create 
Photos pages that are linked 
from another page by simply 
dragging and dropping an 

iPhoto album from the Media 
Browser onto a target iWeb 
page. iWeb automatically 
creates a Photos page of 
the images and adds a 
representative image on the 
main page that links to the 
corresponding Photos page.

>> PuT iMaGes on a dieT. 
iWeb does an OK job of 
optimizing images when you 
publish your site (it slimmed 
down our hefty 9.1MB TIFFs 
into manageable PNGs and 

JPEGs in the 50-to-500KB 
range). But if your pages are 
image-heavy, use an image 
optimizer such as ImageReady 
(part of Adobe Photoshop, 
$649, www.adobe.com) to 
further compress images after 
publishing.

>> order oFF The Menu.  
Don’t like the look of iWeb’s 
navigation menus? Roll your 
own. Add small images or 
shapes to a page, label them, 
and use the Link Inspector to 
enable your new menu items 
as hyperlinks to other pages. 
Don’t forget to turn off the old 
menu in the Page Inspector.

>> shiFT-click To GrouP. 
If you want to make changes 

that impact multiple objects, 
such as moving all elements 
that compose a graphic, Shift-
click each object and then 
edit away.

>> avoid sPaces. Spaces 
in your site’s name lead to 
URL gibberish: “Pounding the 
Pavement” translates to Pound-
ing%20the%20Pavement.

Tips & Tricks
Part of the fun of using iWeb is discovering its hidden 

capabilities—but it’s even more fun if we just tell you about 

them so you don’t have go on a feature safari. Try these out:

Highlight the offending words, 
click Fonts, and select a different 
typeface and size in the resulting 
window. To change the color, 
highlight the text, click Colors, and 
choose a new one from the picker. 
Got more to say? Click Text to add a 
new text box.

To rotate a text block, click the 
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Inspector to open it, and then click 
the ruler icon to display the Metrics 
Inspector. Select the text block and 
use the tools in the Rotate pane; 
the dial for is for free-form flips, 
and the Angle field rotates the box 
by degrees. You can also flip text 
horizontally or vertically by clicking 
the corresponding Flip arrows. 

>> Alignment And SpAcing. 
To customize the text layout 
within a text box, click the T icon 
in the Inspector to display the Text 
Inspector, click Text, and then 
either select an entire text box or 
highlight specific text. In the Color 
& Alignment pane, click the buttons 
to change the text’s horizontal and 
vertical alignment in the box. To 
add a background color, select the 
Background Fill check box, click the 
color swatch, and choose a color 
from the picker.

To adjust the space between 
characters, drag the Character 
slider in the Spacing pane left (to 
squeeze them together), or right (to 
space them apart). Drag the Line 
slider left or right to change the 
space between lines of text.

>> ViSuAl effectS. The Text 
Inspector is stocked with interesting 
bullets, useful if you’ve got lists— 
click List in the Text Inspector and 
choose a bullet style from the 
pop-up menu (you can choose text, 

image, or number bullets, or use 
your own images). To add shadows 
or transparency, open the Graphic 
Inspector (click the square and 
circle shapes icon), highlight the 
text, and use the Shadows and 
Opacity tools.

Text isn’t limited to normal 
boxy constraints—you can use a 
shape as a text box and give your 
messages a truly unique edge. 
Click Shapes and choose one from 
the pop-up menu. Use the points 
along the shape’s edge to resize as 
needed. Then double-click inside 
the shape, type away, and apply 
what you’ve learned to customize 
the text and shape to your liking.

>> WrAp text. To wrap text 
around a photo, movie, shape, 
or other object, place the object 
inside a text box. To do this, 
double-click the text to select it 
and then click where you want the 

object to appear (you should see 
an insertion point). Hold down 
Command and drag a file from the 
Finder or Media Browser to the 
text box to add it, or click Shapes 
(while holding down Command) 
and choose a shape to insert from 
the pop-up menu. To wrap the text, 
open the Text Inspector, click Wrap, 
select the object, and select the 
Object Causes Wrap check box.

>> Prettify your 
Pics and other 
Visuals. If you can select an 
item, you can do almost anything to 
it, including the following:

>> edit imAgeS. If your photo 
needs fixin’, select it, click Adjust 
to open the palette, and use the 
sliders to correct the image’s 
exposure, color, sharpness, levels, 
or other visual oddities. Or click 
Auto Levels to have iWeb optimize 

Don’t be a 
square. Use 
shapes as an 
alternative to 
boring text 
boxes.

 
>> hack the code. If you know 
your way around HTML, CSS, or 
JavaScript, you can alter the code 
to tweak how your pages display 
and function. When you publish 
an iWeb site to .Mac or to a folder, 
iWeb generates all the necessary 
files. Find HTML files at the root of 
your site’s main folder; CSS (with 
the .css extension) and JavaScript 
(.js) files reside inside a page’s 
pagename_files folder.

Hacker’s 
Delight
While iWeb’s pride and joy is allowing 
anyone to create pro-quality Web 
sites without knowing HTML from a 
hamster, code tweakers can rejoice 
in knowing that you can hack iWeb’s 
published pages. If you know a thing 
or two about HTML code, here are a 
few things you can do.

To make our page title and menu more interesting, we tossed a photo behind 
them and used the Adjust palette to tone down the graphic.
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<p>Former 
<i>MacAddict</i> 
editor Kris Fong 
has spent the 
past year and a 
half creating Web 
pages&mdash; 
by hand&mdash; 
for a certain 
fruit company. 
&nbsp;Though 
she &hearts;s 
iWeb&rsquo;s 
nonrequirement 
of HTML code, 
she&rsquo;s still 
having trouble 
adapting.</p>

the exposure and color for you. 
Unfortunately, iWeb won’t let you 
adjust images in the photo grid on 
any Photos page, so don’t waste 
your time trying to move sliders that 
won’t budge.

To rotate or flip images, select the 
item, open the Metrics Inspector, 
and use the tools in the Rotate 
pane to swing images around or 
flip them. You can also add pics 
anywhere on a page (not just to a 
template’s placeholders)—just drag 
and drop them wherever you want.

>> Bye-Bye, Backdrop. To 
change a page’s background, 
select a page in the Site Organizer, 
click the Inspector icon, and click 

the page icon to display the Page 
Inspector. In the Page Background 
pane, choose the type of page 
backdrop you want from the top 
pop-up menu (you can choose a 
color, gradient, image, tinted image, 

or none) and then set the attributes 
for your choice.

>> resize and refocus. To 
move an object (such as an image, 
shape, or movie), click and drag it 
anywhere on the page. To resize 
an object, drag any point along 
its bounding box. Want to crop 
or refocus the subject in your 
photos? Select the image and then 
click Mask. You’ll see a smaller 
bounding box within your chosen 
image. Drag the box anywhere 
within the photo to highlight a 
section, drag the points around 
the box to reframe your subject, 
and then click anywhere outside 
the box to cement your changes.

>> eye candy. 
Want to frame 
your photos? 
Select an image, 
open the Graphic 
Inspector, and 
choose Line or 
Graphical Border 
from the Stroke 
pop-up menu. 
Then choose a 
line or border 
type from the 
resulting pop-up 
menu and set the 
color and frame 
thickness using 
the associated 

settings. You can also change the 
frame design in any photo grid 
using the Graphic Inspector; just 
select the grid and choose a design 
from the Style pop-up menu.

Like text, your photos don’t 

need to be kept in their rectangular 
enclosures; you can make them 
shapely. Click Shapes and choose 
one from the pop-up menu. Open 
the Graphic Inspector, and from the 
Fill pop-up menu, choose Image 
Fill, click Choose, navigate to and 
select an image to insert in the 
shape, and click Open to add it. 
Use the pop-up menu above the 
Choose button to resize your photo 
for the shape.

To have objects cast a shadow, 
select the item and then select the 
Shadow check box in the Graphic 
Inspector. Then adjust the Angle, 
Offset, Blur, and Opacity settings 
to your liking. To add a reflection 
to a photo, select it, and then in 
the Graphic Inspector, select the 
Reflection check box and use the 
slider to control the intensity. To 
change the opacity of an object, 
select it, and in the Graphic 
Inspector, move the Opacity slider 
left to make it more transparent or 
right to make it more opaque.

>> other tweaks. To link 
images or words to other pages, 
add a hyperlink. Select the object 
or text from which you want 
to establish the link, open the 
Inspector, click the curved arrow 
icon to display the Link Inspector, 
select the Enable As A Hyperlink 
check box, choose what you want 
to link to in the Link To pop-up 
menu, and provide the relevant 
information. To change the 
layer arrangement of your page 
elements, select an object and click 
Forward or Backward to move it in 
front of or behind other elements.

 
Open any of these files in a 

text editor (such as BBEdit or 
TextEdit) to edit the code. You 
can change the text, layout, 
links, tables, alignment, 
and other attributes in HTML 
or CSS files, or the site 
functionality in JavaScript 
files. Be forewarned: When it 
comes to code, iWeb files ain’t 
pretty, or necessarily efficient.

>> Hack ElEmEnts.  
Don’t like the look of certain 
iWeb elements? Edit or replace 
them. Once you publish your 
site, take a look through its 
files in column view in the 
Finder. If you’re not keen on, 
say, iWeb’s Email Me or View 
Slideshow buttons, open the 
file in an image editor, edit the 
image, and save it with the 
same name and format.

>> GEt sEarcH 
capabilitiEs. iWeb’s 
search function won’t work  
if you don’t publish to .Mac, 
but Google will provide search 
for free. Go to www.google 
.com/searchcode.html to get 
the code, and then copy and 
paste it into any of your iWeb-
exported HTML pages before 
publishing them.

>> add a Hit countEr.  
Non-.Mac sites won’t display 
iWeb’s hit counter. If you 
want to add one to your site 
(or swap out your .Mac one), 
Amazing Counters (www 
.amazingcounters.com) offers 
some unique designs for 
free. Once you sign up for a 
free account, copy the code 
provided and paste it into your 
iWeb HTML pages.

If you want to make your subjects stand out, use the Mask 
tool to crop and reframe images.
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The Basics
AmpliTude  Technically speaking, it’s the maximum extent 
of the oscillation of a sound wave from its equilibrium point. In 
layman’s terms, it’s how loud a sound is.

BAss  A low-frequency sound usually defined as being from 
below 25Hz up to 200Hz—also the stringed instrument played 
by Flea, Bootsy Collins, and Paul McCartney. It’s difficult for 
we humans to tell where low-frequency sounds are coming 
from; like bats, we’re better at locating the source of higher-
frequency sounds.

deciBels (dB)  As seen in the iTunes equalizer (Edit > View 
Options > Equalizer), decibels are the units of measure for the 
loudness of a sound.

dynAmic RAnge  Measured in decibels, this is the range 
or difference between the loudest and softest points of a song 
that you can play back without distorting the music.

FRequency  The number of times per second that a sound 
wave repeats. Higher frequencies produce sounds we perceive 
as having a higher pitch. Frequencies are measured in cycles 
per second, aka hertz (Hz).

piTch  We use this term to identify musical notes—G or C, 
anyone? A note’s pitch is where it’s located on a musical scale, 
and is defined by the note’s frequency.

Tempo  The speed at which a tune is played.

TReBle  The opposite of bass, above. Barry White and Johnny 
Cash sang bass; Frankie Valli and James Blunt sing treble.

WAveFoRm  The graphic representation of a sound 
wave. It’s what you see when editing or recording music in 
applications such as GarageBand.

Field Guide to AUDIO TERMS

Believe it or not, the world of audio actually extends beyond iTunes and the ipod. When you’re facing well 
over a hundred audio-file formats (if you don’t believe us, see www.sonicspot.com/guide/fileformatlist 

.html and be amazed), understanding the world of digital audio may seem more than a tad overwhelming. 
here’s a first step in comprehending the clouded mysteries of the digital-audio world.

       sound Advice
by Elliot Smith
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Popular File Formats
.aac  Advanced Audio Coding was declared the new audio-file 
standard in 1997, designed to replace its predecessor, MP3. 
It provides better quality at lower bit rates, and it’s Apple’s 
standard iTunes and iPod audio format.

.aiF(F)  Audio Interchange File Format was developed by 
Electronic Arts and Apple back in the ’80s. AIFF files contain 
uncompressed audio, resulting in large file sizes.

.mid(i)  MIDI is not a true audio-file format; rather, it’s a 
music-device-controlling protocol to control instruments using 
computers—and vice versa—in real time. 

.mP3  MPEG Layer 3 is the most popular digital-audio format, 
designed by a team of European engineers in 1991 to conserve 
the quality of a song while presenting it in a small, compact file.

.ogg  Ogg Vorbis is one of the most popular license-free, 
open-source audio-compression formats. It’s efficient for 
streaming and compression because it creates smaller files 
than MP3 while maintaining audio quality. Unfortunately, an 
unhacked ’Pod can’t play OGG files.

.ra(m)  Real Audio Media, developed by RealNetworks in 1995, 
has a wide variety of uses, from videos to music. But it’s mainly 
used for streaming audio such as that from Internet radio stations. 

.wav  Windows WAVE is a an IBM- and Microsoft-developed 
format popular among PC computer users; it can hold both 
compressed and uncompressed audio.

.wma  Windows Media Audio was designed by Microsoft to 
be an MP3 competitor, but with the introduction of iTunes and 
iPods, it’s fallen far behind MP3 and AAC in popularity.

Easy Listening
BEats PEr minutE (BPm)  A way to measure a tune’s 
tempo, representing how many beats are heard per minute of a 
song’s playing time. For example, when listening to a song with 
a BPM of 60, you’ll hear one beat each second.

Bit ratE  A song’s bit rate is a measurement of the amount of 
data being transmitted or processed. As a song is played back 
or recorded, the transfer of data is measured in kbps (kilobits 
per second; a kilobit is 1,000 bits—or 1,024, depending on 
whom you ask). As the bit rate increases, so does the quality 
of the song. For example, although 128kbps is considered to 
be the standard for MP3s in terms of quality versus file size, an 
MP3 file encoded at 192kbps may sound noticeably better.

codEc  An acronym for compression/decompression. Codecs 
are components—either hardware or software—which compress 
the size of a media file during saving and decompress the file 
during playback. 

drm  Also known as digital rights management, these copy-
protection schemes are used by music distributors such as 
Apple’s iTunes Music Store to restrict their songs from being 
played on other computers or digital-music devices.

FairPLay  Apple’s form of DRM, which prevents 
“unauthorized” computers and non-iPod digital music players 
from playing songs bought from the iTunes Music Store.

id3 tag  In MP3 files, the ID3 tag allows song information 
such as the title, artist, album, track number, and so on to be 
stored in the file itself.

LossLEss comPrEssion  Lossless codecs, such as 
Apple Lossless, FLAC, and the file-compression format known as 
ZIP, can compress a file while keeping all of its original quality.

Lossy comPrEssion  This type of codec discards some 
data in order to make song files small—usually, however, the 
drop in quality due to the discarded data is not noticeable 
except to the most discerning ear. MP3, JPEG, and Ogg Vorbis 
are all lossy compression formats. 

mono  Short for monophonic, a mono audio system pumps all 
the sound through only one channel. Even if you have multiple 
speakers connected to your audio source, you’ll hear the same 
sound from each. 

samPLE ratE  A digital audio file’s sample rate indicates 
how many times the signal was measured when it was 
converted from an analog signal to a digital one. Sample rates 
are measured in hertz, and as the sampling rate increases so 
does the audio quality. Also note that to maintain sound quality, 
the sampling rate must be twice the original audio’s highest 
frequency. The standard CD and MP3 sample rate is 44.100kHz.

stErEo  Short for stereophonic, a stereo audio system 
distributes sound through separate left and right channels. The 
amount of the same sound coming from each speaker determines 
where that sound appears to be coming from in the stereo field; a 
sound coming from only the left speaker, for example, sounds as 
if it’s coming from—you guessed it—only the left, while an equal 
amount of a sound coming from both speakers appears to be 
emanating from the middle of the stereo field.

MacAddict intern Elliot Smith spontaneously exploded 
while investigating how low the bass could go. Oops.
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Those aren’t just ventilation holes on Western Digital’s 
My Book Pro (pictured). Those holes carry a hidden 
message, encoded in Morse code. Don’t worry, 
decoding the message isn’t necessary to make the 
My Book Pro work—it’s merely marketingspeak. 
Next month, we’ll uncover the secrets behind 
Apple’s new Mac Pro, Speck Products’ Specktone 
Retro iPod speaker system, Mariner Software’s 
MacJournal 4, Logitech’s unique NuLOOQ in/out 
device, and more.
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Apple’s Shake has long been an 
effects-compositing powerhouse—

so good that it’s regularly used to 
conjure up eye-popping scenes for 
movies such as The Lord of the Rings 
and Pirates of the Caribbean. But now, 
with version 4.1, Shake is no longer the 
tool that only fat-cat Hollywood effects 
shops can afford. Originally priced at 
$2,999, the new Shake (a Universal  
app, no less) now costs only $499 
(OK, you can stop rubbing your eyes 
in disbelief). Shake is roughly half the 
price of competing compositors such as 
Adobe’s After Effects 7 Pro Edition  
(  Jul/06, p38) and Autodesk’s 
Combustion 4 (  Jun/06, p43). 
Shake’s new, lean price makes it a nearly 
irresistible proposition—if you can see 
past a few quirks.

Shake features an impressive lineup  
of hardcore compositing tools. For 
starters, it offers two powerful 
keyers (keying is the act of removing 
an element of an image from its 
background), Keylight and Primatte, 
which can be used individually or 

together to minimize common keying 
headaches. Among many other things, 
Shake’s keyers can pull a sharp key from 
a poorly lit green or blue screen, can 
successfully isolate frizzy hair, glass, 
and other hard-to-key elements, and 
can also remove green or blue tints that 
have spilled off a screen and onto your 
actors. Of course, you’ll find similar 
tools in other compositors, but Shake 
delivers them at a lower price.

Shake also lets you composite 2D 
images in 3D space, creating a sense 
of depth between one element and 
another. It’s easy to tag elements for 
3D treatment, arrange them in 3D, and 
then move a virtual camera around the 
world (along with simulating camera-
lens behaviors such as focal length and 
depth of field). You can’t add 3D light 
sources and shadows (you can in After 
Effects and Combustion), but you can 
match camera moves created in 3D apps 
such as Maya. 

You’ll also find a full-fledged motion 
tracker, which, among other things, 
is handy for mapping an image onto 

another moving 
image (say, slapping 
an advertisement 
onto the side of a 
bus). An image-
stabilization feature 
called Smoothcam 
can take appreciable 
camera shake out 
of footage while 
keeping the final 
image remarkably 
sharp. Likewise, 
Shake uses optical-
flow technology to 
smoothly speed up or 
slow down footage, 
or convert it to slow 
motion, with an 
image quality that 
seems on par with the 
best results found in 
high-end plug-ins for 
other compositors 
and is way ahead  
of what Final Cut  
Pro manages.   

But these core features really only 
scratch Shake’s surface. Beyond 
them, you’ll find world-class color 
correction, vector paint tools, spline-
based morphing and warping, a 
comprehensive scripting language, 
expressions, macros, a plug-in 
architecture, and so on. Also, Shake 
features some basic (if slightly clumsy) 
integration with Final Cut Pro, in that 
you can send individual clips from 
your Final Cut timeline to Shake for 
compositing, and then see the final 
rendered result automatically carried 
back to your Final Cut timeline.   

Still, what’s most important about 
Shake isn’t its bag of features, but its 
out-of-the-box approach to building 
composites. Other compositors such 
as After Effects and Combustion build 
shots by placing layers of footage on 
a timeline and then applying different 
effects to some or all of the layers. It’s a 
familiar approach if you’ve used a video 
editor such as Final Cut or a layer-based 
image editor such as Photoshop. But 
in Shake, you create composites by 

Shake 4.1
nearly Phenomenal Visual-effects comPositor

Shake’s interface takes a little getting used to, but your patience is rewarded.
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building what’s called a node tree, which 
works a bit like a flowchart. Each of the 
visual elements in your scene (actors, 
props, backgrounds) is represented 
as a node on the tree, as is each effect 
you want to apply to those elements 
(chroma key, color corrector, blur). 
Making a composite is simply a matter 
of connecting one node to another in a 
logical order. 

For simple compositing work, a 
node tree may seem no better than a 
layer-based approach, but when your 
composites become more complex, 
Shake’s workflow really shines. Take 
a quick glance at your node tree and 
you can intuitively see how even an 

intricate composite comes together, 
one node at a time. The tree also makes 
it quick and easy to find specific nodes, 
edit them, rearrange their order in 
relation to each other, isolate them so 
you can see their solitary effect on your 
composite, and insert new nodes into 
the workflow. Simply put, it’s a great 
way to work. 

Despite all this, Shake does have 
a few chinks in its armor. For one 
thing, it has virtually no type controls 
or predesigned type-effect libraries 
(unlike After Effects), so if you want 
to do motion-graphics work, you’ll 
have to import rendered text from 
other software. Shake also doesn’t 

have its own particle 
generator, although 
you can create 
particles with Apple’s 
Motion software  
(  Sep/05, 
p42) and then import 
that unrendered 
project into Shake. 

Shake’s main 
weakness is its 
strange user interface, 
which feels like some 
alien concoction 
straight out of the land 
of Unix workstations 
(in fact, that’s exactly 
where Shake got its 
start, years ago). 
It’s not that Shake’s 
interface is bad; it’s 

just unlike any other Mac interface 
you’ve come across, so you can’t use 
what you already know from other 
applications to hit the ground running 
in Shake. For example, to bring in a still 
picture or a video clip, you can’t just 
choose an Import command from the File 
menu, as you might expect. Instead, you 
have to add a File In node to your node 
tree, which then opens a file-selector 
dialog box. Likewise, to render a movie, 
there’s no familiar Export command; 
you have to place a File Out node at the 
end of your composite and assign it a 
destination on your hard drive. 

Shake has more of these weird little 
nuances, and while you’ll certainly get 
used to them after a few days, they’ll 
definitely make the initial learning curve 
steeper. It’s also tough to acclimatize 
yourself to Shake when you’ve been 
away from it for a few weeks or months—
though chances are that if you’re using 
an app like this, you’re going to use it 
full time. It’s an unfortunate contrast 
to an application such as After Effects, 
which is easier to learn because it 
fundamentally behaves like other Mac 
apps, whereas Shake is really an island 
unto itself.

The bottom line. If you can spend the 
extra time to learn The Shake Way, you’ll 
definitely be better off. Quirky interface 
or not, Shake gives you a lineup of 
world-class, battle-tested compositing 
tools, and all for a relative pittance. No 
other software, on no other platform, 
even comes close.—Helmut Kobler

Shake represents each image clip and each operation you might 
apply (chroma key, filter, image stabilizer) as a node. Just arrange 
the nodes to build your composite.

COMPANY: Apple
CONTACT: 408-996-1010,  
www.apple.com
PRICE: $499

REQUIREMENTS: Mac OS 10.4.6 or later; 1GHz or faster 
CPU; 512MB RAM; 1GB disk space; graphics card with min. 
32MB RAM; 3-button mouse; AJA Kona or Blackmagic 
DeckLink card req. for preview on broadcast video monitor.

GOOD NEWS: Tons of high-powered compositing 
tools. Great price. Runs well on MacBook Pros.
BAD NEWS: Un-Mac-like interface. 3D 
compositing lacks lighting effects.

 

Gnomon Workshop Shake Bundle
$300, www.thegnomonworkshop.com

The ultimate path to Shake 
enlightenment, the Bundle delivers  
over 18 hours of high-quality Shake 
training on DVD. You can also buy  
the six individual DVDs within the  
Bundle separately. 

Peachpit Press Apple Pro Training Series: 
Shake 4
$54.99, www.peachpit.com

This book teaches Shake through clear, 
step-by-step lessons and DVD project 
files. Once you get comfortable, Peachpit 
also publishes the Shake 4 Quick-
Reference Guide ($24.99), which acts as a 
map to nearly every imaginable feature.

CreativeCow.net Tutorials
Free, www.creativecow.net

This site has a handful of free tutorials, 
presented via Web videos, that focus on 
specific Shake tasks such as stabilizing  
a shaky camera shot or morphing. 
Search the Cow’s tutorial library to find 
your options. 

GET YOUR SHAKE ON
Shake isn’t the type of application you buy and dive right into, thinking you’ll just figure things out. You’ll need some assistance. 
Here are some Shake guides that we like.—HK 
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Do you prefer Panasonic’s square L 
logo or the recognizable red Leica 
dot? Truth is, it’s all the same. 

H andsomely designed and pretty 
darn cool, the DMC-LX1 is brought 

to you from the minds of both Panasonic 
and Leica. Like other cameras in 
Panasonic’s Lumix line, this one is 
outfi tted with a Leica lens and classic 
Leica design available in either silver or 
matte black. It’s essentially the same 
camera as Leica’s D-LUX 2 (
Jun/06, p42), but the Panasonic version 
offers a nice fi nger-grip on the front 
and a price tag that’s a couple hundred 
dollars less than the one with the 
legendary red-dot Leica logo.

Compact but packed with manual 
overrides and advanced photographic 
features, the DMC-LX1 should be 
tempting for photo enthusiasts who 
want control but not bulk. Leica’s sharp, 
nine-element, f/2.8 to 8.0, 4x zoom, DC 
Vario-Elmarit lens is also a signifi cant 
selling point. What makes this camera 
unique, however, is its adjustable 
aspect ratio. Using a lever on the lens, 
you can easily switch between aspect 
ratios of 16:9 (widescreen), 3:2 (35mm 
fi lm format), and 4:3, the last of which is 

used by most digital cameras. 
The widescreen images aren’t 

produced by in-camera fi rmware 
trickery, but rather the CCD itself—an 
8.6-megapixel sensor designed for 
16:9 capture. The CCD itself is wider 
than your average sensor, and because 
of that some important specs change 
depending on the aspect ratio you 
choose. The effective resolution is the 
most obvious of these specs: The 16:9 
format uses the entire sensor—those 
images use all 8.6 effective megapixels. 
The maximum resolution in the 3:2 
image format is about 7 megapixels, 
and the 4:3 images max out at about 6 
megapixels.

The other signifi cant spec that 
changes depending on the format is 
the apparent focal length of the lens, 
which, in 16:9 mode, is equivalent to 
a relatively wide 28mm to 112mm (in 
35mm camera terms). But if you prefer to 
shoot using the 4:3 aspect ratio, you’re 
zooming with the equivalent of a 34mm-
to-136mm lens.

We appreciate the camera’s easy 

access to such features and its 
overall thoughtful design. The 
mode dial on top of the camera 
lets you select basic capture and 
playback modes, and the familiar 
four-arrows-and-one-select-
button setup on the rear makes 
it easy to fi nd your way around 
menus and playback. Then there 
are extra, unobtrusive controls 
that bestow added benefi ts: A 
small joystick button provides 

menu-bypassing shortcuts as 
well as terrifi c manual control 
over focus, aperture, or shutter 

speed, depending on the capture 
mode. The Display button, when 

held in, doubles as an LCD power 
control for boosting brightness on the 
already impressively crisp, 2.5-inch LCD 
when the camera is in bright light. 

There’s much to like about the 
DMC-LX1, but one important aspect 
of its image quality leaves much to be 
desired. Pictures shot at ISO 200 or 
above are riddled with image noise. 
Using software such as PictureCode’s 
Noise Ninja (  Jan/06, p52) 
helps, but without such doctoring many 
of the higher-ISO images are simply 
unusable. The camera tends to have 
trouble with high-contrast scenes as 
well, blowing out highlights. Generally 
speaking, results are far better at ISO 
100 or below; the camera produces 
natural color and extremely impressive 
detail. Those images can still be a tad 
noisy, but that might be a fi rmware 
concession to bring out detail. The fl ash 
packs good power, too, which can help 
you avoid the higher ISOs. And you can 
also shoot in RAW format, which can 
help reduce noise. 

The bottom line. The DMC-LX1 is an 
innovatively designed, compact camera 
with a host of desirable features and 
manual overrides. But you’ll need to 
decide just how much effort you’re 
willing to put in to avoid or clean up 
those noisy images.—Michael J. Shapiro

Lumix DMC-LX1
WELL-DESIGNED POINT-AND-SHOOT CAMERA

COMPANY: Panasonic
CONTACT: 800-211-7262, 
www.panasonic.com
PRICE: $599.95

REQUIREMENTS: G3 or faster, Mac 
OS X, 400MB disk space, USB

GOOD NEWS: Sharp Leica lens. Wonderful detail. Good manual 
control. Effective optical image stabilization.
BAD NEWS: Images over ISO 100 are noisier than cats in heat.



 Sonos
800-680-2345, www.sonos.com

 $349 (ZP80 only), $999 (bundle that includes two 
ZP80s and a Sonos Controller)

 Mac OS 10.3 or later, amplified 
audio device, broadband connection 

 Small footprint. Effortless installation.
 No support for Apple’s DRM. Pricey.

Last year, we 
reviewed the fi rst 

offering from Sonos, the 
Digital Music System 
(  Jun/05, 
p36), which includes 
the ZonePlayer 100 
and the Controller. 
Sonos now also 
offers the ZonePlayer 
80, a less-pricey alternative 
to the ZonePlayer 100. While 
the ZonePlayer 100 acts as an 
amplifi ed audio device to which you 
connect a set of speakers, the ZonePlayer 
80 is ideal if you have a stereo or other 
amplifi ed audio device with RCA input 
jacks that you want to use for audio output.

Both Sonos systems have two 
parts. The fi rst is the ZonePlayer, a 
well-designed box that allows you to 
play music from your Mac remotely. 
The ZonePlayer 80 (5.4 by 5.5 by 2.9 
inches) is smaller than the ZonePlayer 
100 (10.2 by 8.2 by 4.4 inches), and it 
sports RCA audio-in and -out ports, two 
Ethernet ports, and optical audio-input 
and -output connectors. One ZonePlayer 
must be connected via Ethernet cable 
to your home network, while additional 
ZonePlayers (you can add up to 32) 
connect to the wired ZonePlayer 
wirelessly, using a proprietary wireless 
technology.

The second part is the wireless 
handheld Controller, which has a gorgeous 
backlit display with lighted buttons and an 
intuitive user interface—if you can operate 
an iPod (and who can’t?), you can run a 
Sonos system. The Controller lets you 
control the ZonePlayers individually or as a 
group. Sonos also has software to control 
the ZonePlayers from your Mac.

Installing the ZonePlayer 80 was a 
breeze—it took less than 30 minutes, 

and it’s similar to the setup of the 
ZonePlayer 100. You connect your fi rst 
ZonePlayer to your network with an 
Ethernet cable and then connect the 
ZonePlayer to your audio device using 
the RCA connectors. You can then 
run the setup CD on your Mac or use 
the Controller to confi gure everything 
manually. Pressing the Volume and Mute 
buttons on the ZonePlayer at the same 
time puts it into Discovery mode so your 
Controller and Mac can fi nd it. You show 
the system where your music is stored 
by navigating on the Controller to your 
Mac’s Music folder. You’re done.

Sound quality, of course, will depend 
on the speakers you’re using as well as 
the quality of your music fi les, but we 
experienced excellent sound from our 
installation. Sonos supports many fi le 
types, including MP3, WMA, unprotected 
AAC, Ogg Vorbis, Audible Format 4, 
Apple Lossless, FLAC, WAV, and AIFF 
fi les. Unfortunately, you can’t play songs 
bought from the iTunes Music Store. 
Damn FairPlay DRM.

The bottom line. The ZonePlayer 80 is 
a welcome addition to the Sonos line—a 
great (if still pricey) way to distribute 
music throughout your home without 
messy wires.—James Gross

ZonePlayer 80
LUXURIOUS MUSIC STREAMER

Now it can connect to your stereo.
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When Palm released the Treo 650 
(  May/05, p44), it 

was a near-perfect fusion of PDA and 
phone. While the new Treo 700p is not 
dramatically different from the 650, 
it does provide some nice perks for 
people who spend more time looking at 
information than talking to Mom.

The 700p boasts a ton of similarities 
to its aging sibling: a gorgeous 320-by-
320-pixel display, a QWERTY keyboard 
that’s a little cramped but more than 
usable (the black keys indicate the 
number keys you use to enter a phone 
number), an SD card slot, and a very 
useful ring-silencer switch on top. At 6.4 
ounces and 2.3 by 4.4 by .9 inches, the 
700p is about the same size and weight 
as the 650.

Palm has upgraded some aspects 
of the phone’s design. For one, it has 
increased the amount of user-accessible 
memory from 23MB to 60MB (128MB 
total). It’s also added dedicated send 
and end keys (on the 650, the key 
that takes you to the phone doubles 
as the send key). This should make 
sense to people switching from regular 
mobile phones, although it’s a strange 
adjustment for those who are used to 
the 650. 

Another upgrade is the inclusion 
of a 1.3-megapixel camera, a vast 
improvement over the 650’s VGA cam. 
The 700p also features an enhanced 
media organizer that makes it easier to 
sort and view your pictures and video. 
For music, the phone comes with the 
pTunes application, which you can use to 
listen to MP3 fi les but not AAC (neither 
unprotected nor protected songs 
purchased from the iTunes Music Store). 
The speaker is located on the back, 
which means sounds can be muffl ed 
when you lay your phone down. 

The biggest difference between 
the 700p and the older 650 is data-
transmission speed. The 700p supports 
Sprint’s and Verizon’s high-speed EV-DO 

(Evolution-Data Optimized) services, 
which provides broadbandlike Internet 
access (if you live in an EV-DO coverage 
area) to email and the Web, as well as 
special multimedia capabilities provided 
by the carrier. The 700p certainly felt 
faster than the 650 when running the 
included VersaMail application. Web 
surfi ng via the included Blazer browser 
was a comparative dream. Google search 
results and Fandango came up quickly, 
and although graphics-intensive sites 

such as CNN and Moviefone took longer 
to load, they actually felt usable—unlike 
on a 650. Still missing, however, is a 
built-in instant-messaging client (just 
imagine using the 700p to send an 
instant message to a fellow 700p user. 
Talking on the phone is so passé).

The Sprint-equipped 700p we tested 
also came with a few cool services. We 
dig the On Demand feature, which uses 
your zip code to deliver specialized 
information. For example, you can 
get the top 10 U.S. news or political 
headlines, baseball standings, and 
local TV-guide information. There’s also 
the SprintTV streaming video service, 
which has trailers, music channels, 
Fox’s Prison Break “mobisodes” (mobile 
episodes), as well as other content that 
costs additional dinero. If you want the 
On Demand or SprintTV services, you’ll 
need to spring for one of the Sprint 
Power Vision packs, which cost between 
$15 and $25 per month. One thing that 
Sprint does offer for free is access to 
your Treo user manual, phone support 
(no more trying to remember how to do 
a soft, warm, or hard reset), and on-
demand news headlines from Reuters.

The phone includes other nice 
perks, such as Bluetooth (you can also 
connect using USB), a voice recorder, 
and Documents to Go for working with 
Word, Excel, and PowerPoint fi les on 
the road. The battery is OK; it lasted us 
almost three days, which included about 
an hour and a half of talking and the 
same amount of time browsing the Web, 
checking email, taking pictures, reading 
news, and even watching a little video.

The bottom line. If you’re looking for 
a Mac-compatible PDA phone that does 
equal justice to data and chitchat, you 
can’t do better than the 700p. If you 
already own a 650, it may be hard to 
justify the purchase price unless the 
higher speeds and interactive content 
are that important to you.—Cathy Lu

Treo 700p 
FEATURE-FILLED PDA AND MOBILE PHONE

COMPANY: Palm
CONTACT: 800-881-7256, www.palm.com
PRICE: $649.99 (without service activation), 
$499.99 (with two-year Sprint service)

REQUIREMENTS: Mac OS 10.2 
or later, USB

GOOD NEWS: High-speed data transfers. Cool 
multimedia apps. Great design.
BAD NEWS: Not the most comfortable keyboard for 
typing. Lacks built-in instant-messaging. Expensive.

Broadband Internet access (almost) 
anywhere? Oh yeah!



 Nova Development
818-591-9600, 

www.novadevelopment.com
 $49.99

 G3 or faster, Mac OS 10.2 or later, 
512MB RAM, 1.73GB disk space for default installation

 A ton of templates, clip art, and fonts. Easy to use.
 Can be sluggish at times. Takes up a lot of disk space. 

No photo-correction tools.

Among the range of projects you can 
do with your Mac, personalized 

greeting cards, calendars, scrapbooks, 
and the like may not measure up to that 
brilliant DVD masterpiece you made with 
iLife. In fact, you might even say that 
such projects seem quaint. But they’re 
certainly popular—can you remember 
the last time you got a store-bought 
greeting card? They’re also easy to create, 
especially with Print Explosion Deluxe 3.0.

Print Explosion Deluxe is a humongous 
software package. You can create 
greeting cards, banners, certifi cates, 
labels, posters, fl yers, stationery [pause 
to take a deep breath], party sets (masks, 
hats, and so on), envelopes, invitations, 
postcards, signs, and more [gasp for air]. 
The default software installation requires 
a whopping 1.73GB of storage space—for 
comparison, Adobe Photoshop CS2 and 
Microsoft Offi ce 2004 combined take 
up 850MB of space. It’s not that Print 
Explosion Deluxe is a sloppily coded 
hog; rather, it’s that Nova provides a ton 
of templates. Nova says there are over 
13,000, and while we didn’t count them 
all, we can defi nitely say that the number 

of templates is mind-boggling. 
There are also 900 fonts and 
100,000 clip art images that 
aren’t installed but are included 
on CD-ROMs. 

If you use Print Explosion 
Deluxe’s templates at the most 
basic level, the app is easy to 
use—all you have to do is select 
a template, add photos, and 
customize the text. To add a 
photo, you double-click the area, 

and a navigation window opens, 
allowing you to fi nd the photo you want 
(you can even choose pictures from your 
iPhoto library). Changing the text is simply 
a matter of double-clicking the sample 
text and typing away.

Print Explosion Deluxe is full of tools 
for customizing the templates or creating 
a page from scratch. The problem is 
that the app can be slow to react. For 
example, when moving a simple graphic 
element in one of the templates (before 
any photos were added), we often 
experienced a two-second pause before 
the relocation was performed—and this 
was on a Dual 2GHz Power Mac G5 with 
7GB of RAM. The same pause occurred 
during graphic resizing, cropping, and 
color changes. When making simple 
changes, the pause is tolerable, but 
if you’re making fi ne adjustments or 
building a new page from the ground up, 
this sluggishness can be maddening.

The bottom line. Print Explosion 
Deluxe 3.0 will appeal to you if you love 
to create arts-and-crafts projects on your 
Mac. Nova offers a lot for an attractive 
price.—Roman Loyola

Print Explosion 
Deluxe 3.0
BRIMMING PRINT-PROJECTS SOFTWARE

The new Print Explosion Deluxe 
features scrapbook templates.
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PhotoComplete is designed for 
making adjustments to the overall 

quality of your photos. In the realm of 
photo-editing software, think of it as a 
step above Apple’s iPhoto in terms of 
what it can do, but several steps below 
Adobe Photoshop Elements.

The most obvious difference between 
PhotoComplete and other photo-
processing apps is its interface. If you’re 
familiar with iPhoto, Photoshop CS2, or 

Photoshop Elements, PhotoComplete is 
a departure from the way you’re used to 
working. It has no fl oating palettes, nor 
menus with a list of functions expanding 
halfway down your screen. The interface 
consists of two main parts: On the left 
is the Actions column, which is a list of 
actions you’ve performed on your image 
(in Photoshop terms, think of the Actions 
column as a supersized History palette), 
and on the right is the image, with EXIF 
data and a histogram. Screen space is 
used effi ciently, a nice change from the 
crowded workspace we’re used to in 
Photoshop. The interface is also cleaner 
than iPhoto’s.

Once you start processing your 
photos, you realize how different 
PhotoComplete is from other like-

minded apps. PhotoComplete has just 
16 editing functions (called actions) that 
you can perform, and you can use them 
only on the image as a whole—there are 
no masking functions, no artsy fi lters, no 
magical auto-adjust features, not even a 
red-eye tool. When you open an image, 
you click on the plus-sign button in the 
Actions column, and a menu of the 16 
actions appears. Select a function, and 
a Settings box appears. PhotoComplete 

makes it easy to 
adjust settings 
by using sliders, 
numerical 
values, and 
pull-down 
menus with 
preset settings. 
For example, 
when you select the Crop action, you 
can enter numeric values for width and 
height, or you can select a preset ratio, 
such as 3:2 or 6:4. After you’ve adjusted 
the settings, PhotoComplete applies 
the action—you see your adjustment 
to the entire full-size image, not a tiny 
thumbnail. Don’t like what you see? No 
prob; just press Command-Z to undo.

Perform more actions, and they 

stack up in the Actions column, 
essentially forming a history of what 
you’ve done to the image. This is key to 
PhotoComplete’s strongest feature: You 
can undo any action you’ve performed 
on the image by simply deleting it 
from the list, and all the other actions 
will remain applied to the image. For 
example, say you’ve performed fi ve 
different actions on an image, and 
the third action you performed was 
adding 75-pixel purple border. But 
after performing two more actions, 
you decided that you don’t like that 
border anymore. If you delete the Add 

Border action from the list, the 
two actions you performed after 
applying the border are still intact. 
It’s a time saver because you 
don’t have to reapply the last 
two actions.

PhotoComplete’s actions are 
applied nondestructively, meaning 
that the original photo is always 
available. If you click Read Image 
in the Actions column, you see the 
original image. Another helpful 
feature is that if you click on each 
action in your list sequentially, you 
can see the progression of changes 
made to your photo. However, 
if you save to a fi le format other 
than PhotoComplete’s proprietary 
format (JPEG, TIFF, and PNG are 
available), you permanently apply 
the changes you’ve made.

Other features we like: direct 
uploads from within the app 
to Flickr.com, a limited Curves 
adjustment (which supports 
only two endpoints), and a Black 
& White action that lets you 
adjust individual RGB channels 
instead of simply converting the 

image to grayscale. Valuable features 
missing from PhotoComplete are batch 
processing (which it sorely needs) and 
RAW format support. 

The bottom line. PhotoComplete is 
an inexpensive, useful tool for anyone 
who needs a few more features than 
iPhoto offers but doesn’t want to enter 
the relatively intimidating world of the 
Photoshop duo.—Roman Loyola

PhotoComplete 1.1
STRAIGHTFORWARD PHOTO-PROCESSING SOFTWARE

COMPANY: Funkypixels Software
CONTACT: www.funkypixels.com
PRICE: $39

REQUIREMENTS: 
Mac OS 10.3.9 or later

GOOD NEWS: Nondestructive image manipulation. Can 
perform undos out of sequence and still maintain applied edits. 
BAD NEWS: Basic editing features apply to whole image only. 
No batch processing. No RAW support.

You’ve got 16 actions that you can 
perform on your pics.

Here’s yet another photo-processing app—but with a twist.



Wireless Mighty Mouse
STILL-DISAPPOINTING TWO-BUTTON MOUSE

When Apple debuted its fi rst two-
button mouse, the Mighty Mouse, 

(  Nov/05, p49), we were 
disappointed. Almost a year later, the 
Bluetooth Mighty Mouse has arrived, 
and while we’re all for the wireless 
goodness, the problem is that it’s still 
a Mighty Mouse.

The wireless Mighty Mouse suffers 
from the same defi ciencies as the 
wired version. It looks like a one-button 
mouse, but under its top front lie touch 
sensors that can tell if you’re right- or 
left-clicking. We can live with that, 
but we still don’t like the rest of the 
design—the squeeze buttons on the 
sides of the mouse are too small for large 
hands and don’t give you enough tactile 
feedback; the tiny, clickable Scroll Ball 

has a notchy feel to it; 
and the overall look 
and feel seem to favor 
fashion over function.

The software still 
limits your button-
customization options 
to launching an app 
or activating Exposé, 
Dashboard, or Spotlight. 
You can’t program the 
buttons to execute common 
keystrokes or perform a 
double-click. And you must 
have Mac OS 10.4.6 or later 
to use it. 

On the plus side, the wireless Mighty 
Mouse uses laser tracking; it’s more 
precise than the wired version, which 

uses optical tracking. 
You can use the wireless 
Mighty Mouse with either 
one or two AA batteries; 
you’ll get longer life with 
a pair of batteries, but 
some people like a lighter 
mouse. And if you hold 
the Control key and use 

the Scroll Ball, you can 
zoom in and out
The bottom line. When 
you get right down to 
it, the wireless Mighty 
Mouse is still a Mighty 

Mouse. The laser tracking, lack of a 
cable, and battery fl exibility can’t 
make up for its imprudent design.
—Roman Loyola

Apple
408-996-1010,

www.apple.com
 $69

Mac OS 10.4.6 
or later, Bluetooth, one AA battery 

 Wireless goodness. Looks good. Shutter 
protects the laser lens when you turn off the mouse. New 
zoom function.

 It’s still a Mighty Mouse.

Saving the day? Not likely.
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      RAW DEAL
Many high-end digital cameras give you 

to option to save fi les in RAW format. In 

simple terms, a RAW fi le contains the 

unaltered images recorded by the camera’s 

sensor. When you save fi les in a camera 

using JPEG or some other format, the 

camera processes the fi le and applies 

compression before saving it. A RAW fi le 

gives you more fl exibility when it comes 

to image editing, but the fi le sizes are 

much larger than JPEG. Devices such as 

the FlashTrax XT or the iPod let you offl oad 

images from your camera, opening up your 

camera’s storage for more photos.

SmartDisk’s FlashTrax XT is a 
hard drive–based digital-media 

storage device and player. It’s a viable 
alternative to an iPod if your primary 
need is photo storage, but it can also 
play videos and music and provide 
easy access to data fi les when you’re 
on the road.

Measuring 6.22 by 3.82 by 1.38 
inches and weighing 15 ounces, the 
FlashTrax XT is much bigger than an 
iPod. It has a fl ip-top 3.6-inch, 320-by-
240-pixel LCD screen for viewing videos 
and digital photos; you can place the 
FlashTrax XT on a table and comfortably 
watch what’s on it. But don’t try to judge 
the quality of your images by what you 
see on the screen—it’s not very sharp, 
and it’s diffi cult to see in bright daylight.

The FlashTrax XT can record and play 
back video from any camera or television 
set with video-out connectors (a video 
cable is included). Connect your TV 
or camera to the FlashTrax XT, push a 
button, and the FlashTrax XT records. 
You can also download digital video 
fi les from your Mac to the FlashTrax XT 
via USB. Compatible video fi le formats 
include MPEG-4, DivX, WMV9, and 
XviD. If you have a video encoded with 
QuickTime, you have to fi rst convert it to 
one of the supported fi le formats using 
an app such as Apple’s QuickTime Pro.

In the cards. The built-in card reader 
supports CompactFlash cards and 
Microdrives, but you’ll need SmartDisk’s 
optional Media Adapter ($49.99) to read 
SD, MMC, SmartMedia, Memory Stick, 
and Memory Stick Pro cards. In either 
case, downloading your fi les is easy: Just 
insert a memory card into the slot and 
copy its fi les to the FlashTrax XT’s hard 
drive with the push of a button.

The FlashTrax XT supports JPEG, 
BMP, and GIF for photo playback. When 
it comes to displaying RAW digital fi le 
formats (supported RAW fi les include 
Canon, Nikon, Olympus, and Pentax), 
the FlashTrax XT actually displays the 

JPEG embedded in the RAW fi le. 
When we used the FlashTrax XT to 
store RAW photos from a Nikon D200 
camera, the FlashTrax XT showed an 
incorrect fi le size for the RAW fi les. 
Fortunately, our images weren’t 
damaged or changed when we then 
transferred them to the Mac.

You can use the FlashTrax XT as a 
music player, but it supports only MP3 
and WMA audio formats—you can’t play 
songs bought from the iTunes Music 
Store. You can use iTunes to convert your 

purchased songs or songs ripped from 
CDs to MP3s, but when you reprocess 
the iTMS songs, you’re likely to degrade 
the sound quality.

You can also make audio recordings 
with the internal microphone, but you 
must awkwardly access the Setup 
controls every time you want to use the 
audio-recording function. The sound 
quality isn’t the greatest, but it’s usable 
and convenient if you need to make 
voice notes about locations and scenes 
you’re photographing. The FlashTrax 
XT also has a built-in FM tuner that can 
record radio content in MP3 format.

When connected to a Mac via USB, 
the FlashTrax XT functions as an external 
hard drive on your desktop, and you 
can use it to store any fi le format. The 
FlashTrax XT may not be able to read and 
play back all the fi les you transfer to it, 
but it can at least store them for you.

The bottom line. The FlashTrax XT’s 
strength lies in its ability to easily and 
effi ciently store and display lots of 
photos. As a multimedia device, it’s 
merely OK.—George Mann

FlashTrax XT
PORTABLE MULTIMEDIA PLAYER

COMPANY: SmartDisk
CONTACT: 239-425-4000, www.smartdisk.com
PRICE: $399.99 (40GB, tested), $299.99 
(20GB), $499.99 (80GB)

REQUIREMENTS: 
USB-equipped Mac

GOOD NEWS: Easy to use for file transfers and recordings. 
Large LCD for viewing photos.
BAD NEWS: Average-quality video, audio, and photo 
playback.

Oh, how we wish 
Apple would just 
come out with that 
big-screen, touchpad 
iPod video.



Mouse-Friendly 
Keyboard
ERGONOMIC KEYBOARD FOR RIGHTIES

The Mouse-Friendly Keyboard’s numeric keypad is on the left 
side of the keyboard, so if your arm gets tired from using your 

mouse, this might help—if you’re right-handed. Evoluent’s theory 
is that the mouse will be more in line with the natural position of 
your arm. Our posture did improve, but we found the layout of the 
clicky, laptop-like keys too tight. Designed for Windows, it has 
function keys that don’t work on a Mac, and the Wake, Sleep, and 
Power keys have the same effect as pressing the Mac’s power 
button. Since there’s no software to remap the keys, you’re stuck 
with some that are essentially dead (to Evoluent’s credit, its Web 
site and the box do state that some keys won’t work with a Mac).

The bottom line. It’s mouse- and posture-friendly, but it has 
a long way to go before being Mac-friendly.—Brian Moore

Mouse-friendly? 
Yep. Mac-friendly? 
Eh, not so much.

Evoluent
650-355-2467, 

www.evoluent.com

 A bit more comfortable in a 
neutral position. Nice and heavy.

 Some hot keys don’t work on a 
Mac. Righties only. Cramped layout. 

 $64
USB

Microsoft
800-642-7676, 

www.microsoft.com

 Many hot keys. Great 
wireless reception. Mac-specific keyboard.

 Fixed keyboard wrist pad. 
Mouse designed for righties.

 $99.95
Mac OS 10.2 or later, USB, 

30MB disk space, 4 AA batteries (included)

Wireless Laser 
Desktop for Mac
ERGONOMIC KEYBOARD AND MOUSE

This set includes Microsoft’s 
Wireless Laser Mouse 6000 

and the Wireless Comfort 
Keyboard. It uses RF to 
transmit signals between 
the input devices and the 
USB receiver. The smooth-
gliding mouse is comfortable 
for righties with medium to large 
hands, and its fi ve buttons and four-
direction scrollwheel can be customized 
easily. Ours even survived a coffee spill. 
The slightly curved keyboard has customizable hot keys; our only 
qualm with it is that the wrist pad can’t be removed or adjusted.

The bottom line. The Wireless Laser Desktop for Mac is 
feature-fi lled and comfortable.—Roman Loyola

Should you replace 
your Apple keyboard 
with this one? Yup.
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If you need to record pro-quality 
audio with minimal fuss, M-Audio’s 

MicroTrack 24/96 is a self-contained 
wonder, smaller than anything else that 
can do this kind of stuff. Pity it’s not 
built as well as we’d like.

The MicroTrack captures audio with 
up to 24 bits and 96kHz of sampling 
quality onto CompactFlash cards and 
Microdrives, making it perfectly 
suited for on-the-go professional 
audio production. It has a 
pair of TRS input jacks for 
line-level sources (such 
as the master outputs 
of a mixing board) or 
microphones (either 
standard or phantom 
powered), a single stereo 
minijack for electret mics, 
and an S/PDIF input jack 
for recording directly from digital 
sources. A pair of RCA output jacks, a 
headphone jack, and a USB 2.0 port 
round out the I/O options.

The MicroTrack saves sound as 
uncompressed WAV fi les or compressed 
MP3s with selectable compression 
ratios. The audio quality is great, but we 
did fi nd one quirk: At press time, there 
was no way to capture mono audio. M-
Audio says it’ll add support in a future 
fi rmware update.

The included USB cable makes 
connecting the MicroTrack to a Mac a 
total snap, and the device shows up on 
the desktop like any other drive. The Li-
Ion battery can be charged via the USB 
connection (make sure you’re using a 
powered USB port) or with the included 
AC power connector. While the battery 
carries a decent charge (around four 
hours with the bundled electret mic or 
line inputs; as little as 2.5 hours with 
a phantom-powered microphone), you 
may one day need to ship the unit back 
to M-Audio when the battery no longer 
can hold a charge—a $75 hassle.

The MicroTrack is just a tad larger 

than a fi rst-generation iPod and made 
mostly of plastic, so we’re a little 
nervous about how it’ll hold up in 
the fi eld in the long run. The prime 
candidate for breaking off is the main 
navigation control on the left side of the 
unit, which is used for moving between 
menu items (by pushing up and down) 
and for selecting menu commands (by 
pushing in). We wish this control switch 
felt more solid.

Another major issue we encountered 
is that the phantom-power rating of the 
unit is weak. Instead of the standard 
48-volt specifi cation of most powered 
jacks, MicroTrack phantom power tops 
out at 30 volts, which might present a 
problem for certain microphones and 
could result in low input levels and 
increased distortion. Check the list of 
tested microphones on M-Audio’s Web 

site to make sure you’re 
in the clear. If you 

don’t already have 
a microphone, 
you’ll defi nitely 
appreciate the 

tiny stereo electret 
microphone included 

in the package. It’s not 
going to replace a pro 
mic, but it’s unobtrusive 
and totally serviceable. 
The overall interface is 

incredibly straightforward 
and effortless, with dedicated 

buttons for setting levels, 
recording, locking the unit, 

deleting fi les, pausing recording, 
and getting to the main menu. The LED 

indicators for recording and input-signal 
peaks are welcome and help visually 
determine appropriate recording levels. 
One glaring omission we encountered 
was the lack of a limiting circuit—a 
sudden loud burst of sound while 
recording will drive the captured audio 
into overload clipping. This is defi nitely 
a concern for recording live music or 
sound effects.

The bottom line. The MicroTrack 
24/96 is a cool little device that 
makes fi eld recording a snap, but 
we’d love to see it made with a little 
more metal—and we don’t mean Judas 
Priest.—David Biedny

MicroTrack 24/96
SERVICEABLE MOBILE AUDIO RECORDER

COMPANY: M-Audio
CONTACT: 626-633-9050, 
www.m-audio.com
PRICE: $499.95

REQUIREMENTS: Mac OS 10.3.9 or 
later, CompactFlash storage

GOOD NEWS: Small footprint. Easy to use. Excellent 
recording quality.
BAD NEWS: Questionable build quality. Phantom power 
a little weak. No audio-limiting circuitry.

Handy for location recordings such as 
podcast interviews.
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      GUIDED BY VOICES

You probably think a device such 

as the MicroTrack 24/96 works well 

for podcast interviews. You’re right, 

but there’s more you can do besides 

choosing the device to get the best 

voice recordings. Find a spot that’s as 

quiet as possible for your interview. 

If you’re out in the city, move away 

from the street and crowds. Talk in a 

carpeted room, if possible—carpeting 

can muffl e residual noise and echoes.



HP
www.hp.com

 $79.99

Mac OS 10.3.9 or later, USB

 Small. Good print quality. Easy-to-use one-touch 
buttons for scans and copies.

 No duplex. No fax. You’ll need to have extra ink 
handy. No PictBridge connector.

The Deskjet F380 is an inkjet color 
printer, copier, and scanner that’ll 

save a ton of space on your desk, and 
its up-front cost is cheap. But make 
sure you hang on to the dollars you 
save—you’re going to need them to 
buy extra ink.

Measuring 16.8 by 7 by 10.2 
inches, the F380 is ideal for that 
corner spot on your desk—it’s 
defi nitely a space saver. Leave space 
above the F380, though, because 
you’ll need to lift open the scanner lid 
when scanning something. 

The 4,800-by-1,200-pixels-per-
inch printer uses two ink cartridges. 
For printing text and basic graphics, 
it has one tricolor cartridge (cyan, 
magenta, yellow) and a black 
cartridge. When you want to print 
photos, you can pop out the black 
cartridge and replace it with a three-
color HP photo ink cartridge ($24.99). 
Using six colors gives your photos 
better color fi delity—but make sure 
you have some extra ink handy. 
The cartridges are rated to last 125 
pages, but that can vary depending 
on what you’re printing and what 
print quality you select. For example, 
we ran out of black ink after printing 
154 pages of text at Normal quality; 
however, when printing 15 Keynote 
slides (each with a blue, full-bleed 

background), we ran out of cyan ink 
after only eight slides.

The F380 isn’t fast, but you 
get what you pay for. It took over 
10 minutes to print a 50-page 
monochrome text fi le. It took nearly 
20 minutes to print our 15 Keynote 
slides at Normal print quality. The 
1,200 dpi scanner took 24 seconds to 
scan a 4-by-6-inch color photo at 300 
dpi—good speed. A color copy of an 
8-by-10-inch page took 80 seconds; 
a black-and-white copy of the same 
page took 44 seconds. Not bad for 
such a mighty mite.

Text is not laser quality, but it’s 
better than acceptable. Our color 
charts had nice saturation and 
vibrancy, and our slides didn’t show 
any banding. In fact, our full-bleed 
slides didn’t warp plain paper as 
badly as we’ve seen with other inkjet 
printers. And you defi nitely need to 
spring for the photo ink cartridge, 
because the color accuracy is much 
better than with just the four basic 
colors. Our photos looked accurate 
and sharp, though we noticed a slight 
magenta cast to them.

The bottom line. The F380 is a 
capable all-in-one for either a single 
user or an offi ce that has low-volume 
printing and scanning demands.
—Roman Loyola

Deskjet F380
COMPACT ALL-IN-ONE

Small-in-one.
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My Book Pro
NIFTY EXTERNAL HARD DRIVE

Western Digital’s My Book Pro 
is an external hard drive. The 

company, known for its internal hard 
drive mechanisms, also makes drives in 
external enclosures. The My Book Pro 
has a friendly, booklike case design, 
instead of your more generic, plain-
Jane case.

Measuring 6.78 by 5.63 by 2.23 
inches, the drive’s silver plastic case 
has a pair of helpful LED rings gracing 
its face. The smaller, inner LED acts 
as a capacity indicator to give you a 
rough idea of your remaining space. For 
example, if the ring is a quarter lit, the 
drive’s a quarter full. When the drive is 
reading or writing, the outer LEDs appear 
to rotate clockwise to tell you the drive 
is active. The button in the middle of the 

LED rings powers the 
quiet, fanless drive 
on or turns it off.

The drive has a 
USB 2.0 port, two 
FireWire 800 ports, 
and a FireWire 400 
port. Using Xbench 
(free, www.xbench
.com) to gauge the speed 
of the drive on a Dual 2GHz 
Power Mac G5, we found 
that the My Book Pro posted a speed of 
32MB per second during the Sequential 
Uncached Write test when using FireWire 
400 or 800. For comparison, the internal 
160GB SATA drive in the Power Mac was 
rated at 37MB per second on the same 
test. On the Sequential Uncached Read 

test, the My Book Pro 
(using either FireWire 400 
or 800) and the internal 
drive both were rated at 
36MB per second. Using 
USB, the My Book Pro was 
rated at 10MB per second 
in both tests.

   The drive comes 
with Retrospect Express 
6.1 backup software. Its 
interface isn’t elegant, 

but once you fi gure it out, Retrospect 
Express is a capable backup app.

The bottom line. Where else can 
you fi nd a case that uses a marketing 
message in Morse code for its cooling 
vents? The My Book Pro is a great 
external hard drive.—Roman Loyola

COMPANY: Western Digital
CONTACT: 949-672-7000, 
www.westerndigital.com
PRICE: $349.99 (500GB, tested), $219.99 (250GB)

REQUIREMENTS: Mac OS 10.2.8 
or later; FireWire 400, FireWire 800, 
or USB port

GOOD NEWS: At-a-glance capacity 
indicator. Triple interface.
BAD NEWS: Bundled Retrospect 
software lacks interface elegance.

Decoder card not included.

Advertisement

iPod Showcase

Banshee Listening Station

The only 5.0 surround system in 
a single listening station.
Shatter the perceived limitations of 
audio for your iPod with a massive 
50 watts of peak output power. The 
Banshee’s patented technology 
produces ultracrisp midranges with 
deep and powerful bass. Available 
at RadioShack, select Circuit City 
stores, Discovery Channel Stores, 
and Chicago-area Abt Electronics 
locations.
www.BansheeAudio.com
312-474-6108

iPod Mounting Solutions

Taking your music with you 
is even easier with ProClip!
ProClip mounting solutions are 
the best way to mount your iPod in 
your vehicle. The mount clips on in 
seconds without interior damage. 
For details on ProClip mounting 
solutions for your iPod as well 
as your other devices, visit:
www.proclipusa.com
800-296-3212

iPodCopy is a Mac/PC 
application that lets you 
retrieve music from your iPod.
Use iPodCopy to extract your music 
and videos from your iPod straight 
back to iTunes. Really useful if 
you loose all your media on your 
computer following a reformat. 
www.wideanglesoftware.com/
ipodcopy/

iPod Repair

Everyone drops their iPod now 
and again, but if it breaks, 
what do you do?
The professionals at iPodMods
.com have a solution for you. We 
offer free diagnostic testing and 
have what it takes to fi x every iPod 
problem. Get your iPod juiced up 
and tuned up with the real iPod 
experts.
www.iPodMods.com
888-763-6637
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iPod Music Liberator

Liberate your music.
The iPod Music Liberator lets you 
copy music, videos, playlists, and 
ratings from your iPod to your 
computer, a key feature missing from 
iTunes. With the iPod Music Liberator 
you can recover music from your 
iPod if your computer crashes, 
make a backup of your music, and 
move music to another authorized 
computer. If you have an iPod, you 
need the Music Liberator. Visit our 
site and email us the code A816 for a 
chance to win an iPod nano!
zeleksoftware.com/liberator.htm

Icuiti iWear

See the big picture with 
Icuiti’s iWear.
iWear is a personal big-screen 
display that will transform your 
small 2-inch screen into a large, 
private 35-inch home theater. 
It attaches to and draws power 
from the iPod’s bottom dock 
connector and is worn like a pair of 
sunglasses. 
www.icuiti.com

Advertisement

iPod Showcase

Elite Audio Gear

6i Isolator Earphones deliver 
detail, balance, comfort, 
and value. 
The in-ear secure fi t reduces 
background noise so you can listen 
at safe levels. Hear crisp, clear 
music inside your head. Great for 
travel and working out. Available 
online or at Apple Stores and other 
retail locations worldwide.
www.etymotic.com

TUNEBUDS

COMPANY: 
Griffin Technology
CONTACT: 
615-399-7000, www 

.griffintechnology.com
PRICE: $34.99
REQUIREMENTS: 
iPod nano

GOOD NEWS: Good sound quality.
BAD NEWS: Provide your 
own case.

Rhythm with Grab and TuneBuds
WEARABLE iPOD NANO LANYARDS

R ivet’s Rhythm with Grab and 
Griffi n’s TuneBuds are lanyards 

for the iPod nano—they’re for anyone 
who owns a nano and wants to wear 
it proudly.

Rhythm with Grab. The Rhythm with 
Grab has a plastic case that protects 
your nano. The plastic doesn’t feel 
brittle, but it does feels like the type that 
can snap with a moderate amount of 
force. A nice little touch is that you can 
also detach the case from the lanyard 
and use the built-in clip to latch the case 
to your belt.

When wearing the lanyard, you can 
use a slider to adjust the cables around 
your neck. The earbuds produce a good 
range of sound, though we noticed a lack 
of warmth. 

TuneBuds. You attach your nano to the 
TuneBuds using the headphone/dock 
connector. It doesn’t include a case for 
the nano, but you can use your own case 
if it doesn’t interfere with the nano’s 

bottom connectors.
You can’t adjust the lanyard. We 

preferred the TuneBuds’ richer-sounding 
audio quality over the Rhythm with 
Grab’s—but not by much.

Both of these lanyards come 
with different-sized earpads so 

you can get the right fi t for your ears. 
The bottom line. We could go either 

way with these lanyards. If only we 
could combine the Rhythm with Grab’s 
lanyard design with the TuneBuds’ 
sound quality. Then we’d have a clear 
winner.—Roman Loyola

Functional nano neckwear.

COMPANY: Rivet
CONTACT: 
877-748-3866, 
www.rivetnow.com

PRICE: $49.99
REQUIREMENTS: 
iPod nano

GOOD NEWS: Includes protective case. Adjustable 
lanyard.
BAD NEWS: Questionable 
case durability.

RHYTHM WITH GRAB
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The browser interface lets you see what’s playing, control various 
settings, and get lots of online help.

When you attach the Squeezebox 3 
to your stereo or powered speakers 

and use the remote control to connect 
to your Ethernet or Wi-Fi network, you 
can play the music from your Mac to 
wherever your Squeezebox 3 is located. 
When we reviewed the Squeezebox 2 
(  Dec/05, p53), we dinged it 
for its complicated setup and high price 
compared to its main competitor, the 
Roku SoundBridge (  Feb/05, 
p46). These complaints are still true 
of the Squeezebox 3, so what makes it 
better than its predecessor? Two things: 
It has a better design and it 
does more.

The core components of the 
Squeezebox 3 are the same 
as the previous version’s: a 
Burr-Brown 24-bit DAC, gold-
plated RCA connectors, optical 
and coax S/PDIF ports, and an 
Ethernet port. The sound quality 
is noticeably better than the 
SoundBridge’s (assuming you 
play it through a system that 
can take advantage of the difference in 
quality). The Squeezebox 2 looked like a 
router, but the stylishly sleek, thin, 7.6-
by-3.7-by-3.1-inch Squeezebox 3 looks 
like something that belongs with a nice 
stereo system.

Once you get the Squeezebox 3 on 
your network, you need to go to the 
Slim Devices Web site and download 
the free, open-source SlimServer app, 
which installs as a Preference pane in 
Mac OS X’s System Preferences. When 
you fi rst launch the app, you point it at 
your Music folder, and it recognizes your 
iTunes library—the Squeezebox 3 can 
play MP3, WMA, FLAC, WAV, Ogg Vorbis, 
and AAC fi les, but not iTMS-bought 
protected AAC fi les. Click the Web 
Access button to launch the SlimServer 
interface in your Web browser, and you 

can browse your library, start and stop 
play, and modify settings for the server 
and player, such as the various interface 
options.

The current version of the SlimServer 
software fi xes the earlier problem of not 

picking up changes made 
in iTunes, such as deleting 
playlists or songs. In the 
Server Settings part of the 
browser interface, you can 
set how long the software 
will wait between updates 
of your iTunes library 
information.

Squeezebox 3 can 
connect directly (sans Mac) 
to thousands of Internet 
radio stations, such as 

Live365, SHOUTcast, and radioio. You 
can also connect to a custom music 
feed at Pandora.com, a site that lets you 
create personal radio stations. Imagine 
having access to a radio station that only 
plays music that sounds like what you 
already like—it’s a revelation. And you 
can connect to the Live Music Archive 
(www.archive.org) and stream entire 
concerts from bands that have permitted 
access to their performances, ranging 
from the reasonably well known (Béla 
Fleck and the Flecktones, Big Head Todd 
and the Monsters, the Grateful Dead) 
to bands we can pretty much guarantee 
you’ve never heard of. For comparison, 
the SoundBridge allows only 15 preset 
Internet radio stations.

The bottom line. The wireless 
Squeezebox 3 costs twice 
as much as the entry-level 
SoundBridge, so if all you want 
to do is stream music from 
iTunes, the SoundBridge is a 
better choice. But since our last 
comparison, Internet radio has 
grown to be a signifi cant part of 
our musical diet, and here the 
Squeezebox 3 is a clear winner. 
Add in other features—such as 
SlimServer’s ability to stream 

music to multiple rooms with the 
addition of more Squeezebox 3 units (or 
even SoundBridges) and the Ethernet 
bridge features—and the extras go a 
long way toward justifying the price.
—Jake Widman

COMPANY: Slim Devices
CONTACT: 650-210-9400, 
www.slimdevices.com
PRICE: $249 (wired), $299 (wireless)

REQUIREMENTS: Mac OS 10.3 or 
later, Ethernet or Wi-Fi network

GOOD NEWS: Good sound. Recognizes iTunes 
playlists. Extensive Internet radio options.
BAD NEWS: Pricey. Requires separate software 
download.

Squeezebox 3
ROBUST DIGITAL-MUSIC STREAMER

It’ll look cool in your home 
entertainment center or with a 
set of powered speakers.
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An up-and-coming politician once wrote that it takes a village 
to raise a child. But how ’bout raising a virtual village? All that 
takes is you! Last Day of Work’s Virtual Villagers is a simulator 
in which you 
take care of 
a village’s 
inhabitants, 
teaching them 
the ways of 
survival while 
tending to 
their food, 
housing, 
and health 
needs. Unlike 
many other 
sim games in 
which time 
stops when you 
quit the app, Virtual Villagers (like the company’s other sim 
games, Fish Tycoon and Plant Tycoon) keeps going even after 
you press Command-Q—your villagers continue to develop 
during the after hours.—Roman Loyola

COMING SOON

Village People

Last one in the lagoon is a virtual rotten egg!

57
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Cold War
In the new stealth-action game Cold War ($34.99, www.rune-soft
.com), you play journalist Matthew Carter, drowning in conspiracies 
and framed for assassinations. These tips might mean the difference 
between a virtual Pulitzer Prize and death in Siberia.—Matt Osborn

War—even a 
cold war—is hell.

■ Examine everything—and we 
mean everything. You never 
know what junk you might need 
to build gadgets. 

■ You’ll do some backtracking in 
Cold War, so remember where 
the best hiding places are. Crouch 
in the shadows, and use the 
light meter.

■ Snapping Matt’s fi ngers, throwing 
objects, or using an alarm clock 
can distract guards—but make 
sure you are well hidden in the 
shadows when you do.

■ Use your trusty X-ray camera to 
scope out potential threats, and 
don’t forget to disable security 
devices, knock out guards, and 
ignite fl ammables.

■ Light fi xtures are made of 
Plexiglas. Don’t waste your ammo 
shooting at them in an attempt to 
create darkness for hiding in.

■ As soon as you can, learn how to 
make rubber bullets. They come in 
handy. Trust us.

■ Unconscious foes eventually 
wake up, so hightail it out of there 
before they do.

DEV/PUB: Last Day of Work, www.virtualvillagers.com 
AVAILABLE: Now  ■  PRICE: $19.95  

VIRTUAL VILLAGERS

TIPS & TRICKS

COMING SOON

Hedgehogs, Move Over
Scared armadillos usually roll up into a protective ball, 
but not Armado, the title character in Tricky Software’s 
latest game. Instead of being roadkill, he fi nds himself in 
a platform adventure that tests his quick refl exes against 
spiders, ants, scorpions, and other dangers. As Armado, 
you travel through sunny woods, snowy mountains, and 
simmering volcanoes. Although Tricky Software may 

be new to you, its 
team members 
aren’t new to game 
development; as 
alumni of Electronic 
Arts, they bring 
together many years 
of game-design 
experience.—MO

Tricky Software’s 
Armado serves 
up armadillo on a 
platform.

DEV/PUB: Tricky Software, www.trickysoftware.com
AVAILABLE: October  ■  PRICE: $19.99  

ARMADO
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Fish Tycoon 1.0
ENTERTAINING FISH SIMULATOR

Virtual aquarium = no cleaning.

Fish Tycoon isn’t as complex as most 
other simulation games, but it can 

still provide plenty of hydro-happiness 
for your whole family.

In Fish Tycoon, you breed and sell 
fi sh—live ones you might see at a pet 
store, not the kind served for dinner. You 
start with $300 and two fi sh tanks, then 
buy eggs to hatch your fi rst set of fi sh. 
Once they’re mature, you can breed them 
by placing two fi sh into an isolation tank, 

where one gets ichthyologically knocked 
up. Soon, new babies are born, and 
you get more fi sh. You can also sell the 
mature fi sh—this is, after all Fish Tycoon; 
you’re running a business. Nothing’s 
complicated about buying eggs (you go 
to the supply store, click an item, and 
buy it), breeding fi sh, and selling them 
(click the Sell Fish button to activate a 
storefront mode where virtual customers 
come and buy your fi sh). The easy play 

means you get your business up 
and running quickly. So satisfying.

Like most sim games, Fish 
Tycoon requires a period of time to 
pass before an action is complete. 
For example, a pregnant fi sh can 
take about 30 real-time minutes 
to deliver its babies. We found a 
cheat for this, but we won’t spoil it 
for you—we’ll just say it involves 
System Preferences > Date & Time.

Fish Tycoon could use more features, 
such as a way to tell if a fi sh is pregnant 
(you have to click an individual fi sh 
to read its status). This would reduce 
tedium, especially when you’re trying 
to unveil the over 400 kinds of fi sh. 
And we can’t help but wish the game’s 
graphic quality rivaled that of the Marine 
Aquarium screen saver ($19.95, www
.prolifi c.com).

The bottom line. Considering the low 
price and the hours you’ll spend with it, 
Fish Tycoon is a great deal.—RL

Blizzard recently announced more details about the two 
new races to be included in the upcoming World of Warcraft 
expansion pack, The Burning Crusade—namely, that these 
races will include classes that were previously unavailable in 
each of WOW’s factions. The new Draenei race for the Alliance 
faction will have a shaman class available, while the new 
Blood Elf race for the Horde faction will have a paladin class. 
Previously, no Alliance race had a shaman class, and no Horde 
race could be a paladin. Hardcore WOW players (hmm...we 
thought the only people who play WOW are hardcore players) 
on Blizzard’s message boards were initially disappointed with 
the announcement, but Blizzard says that Horde paladins 

and Alliance 
shamans will 
have unique 
abilities to 
maintain 
each classes’ 
value.—RL

COMING SOON

Horde Paladins and 
Alliance Shamans

The makers of the turn-based Legion series are trading in their 
Roman spears for Springfi eld M1903 rifl es in their next turn-
based strategy sim title, Commander: Europe at War. The game 
takes place between 1939 and 1944, with all of Europe and some 
of Africa and Russia covered in a 2D hex-style playing fi eld. In 
single-player mode, you choose to play as the Allied or Axis 
forces and then plan your strategies, collect resources, build 
forces, and use shock tactics (these reduce enemy morale but 
are affected by the terrain) to defeat your adaptive AI foes. Two 
players can duke it out via LAN or email, and online you can limit 
the time you get for each turn. Will you defeat the Axis, or will 
Nazis vacation in London in 1945?—MO

The makers of the turn-based Legion series are trading in their 
Roman spears for Springfi eld M1903 rifl es in their next turn-
based strategy sim title, Commander: Europe at War. The game 
takes place between 1939 and 1944, with all of Europe and some 

COMING SOON

World War II-D

Play ball! 
Pallies in the 
house. Finally!

GREAT
RATED

GOOD NEWS: Addictive. Easy to learn. Lots of 
fish varieties.
BAD NEWS: Unsophisticated graphics. Lacks 
features that could make the game less tedious.

COMPANY: LDW Software
CONTACT: www.ldw.com
PRICE: $19.95
REQUIREMENTS: Mac OS 10.2 or later, 30MB 
disk space

Yep, Italy still 
looks like a 
boot.

DEV/PUB: Firepower Entertainment and Slitherine Software, 
www.slitherine.com  ■  AVAILABLE: TBD  ■  PRICE: TBD  

COMMANDER:
EUROPE AT WAR DEV/PUB: Blizzard, www.blizzard.com 

AVAILABLE: End of 2006  ■  PRICE: TBD  
WORLD OF WARCRAFT:
THE BURNING CRUSADE



Call of Duty 2
FIRST-PERSON-SHOOTER TOUR 
DE FORCE

Fashion Fable
QUIRKY MATCH-THREE 
PUZZLE GAME

In match-three puzzle games, you play on a grid full of 
different objects and try to line up three like objects by 

moving adjacent pieces; these games are easy to learn and 
can be satisfying. The catch is that the dozens of match-three 
games out there are too much alike. Then there’s Fashion Fable, 
a match-three game that adds a fashion-plate twist.

You play as 
Asha, a fashion 
designer whose 
clothes have 
morphed into imps 
that she has to 
collect. How does 
she do that? You 
guessed it, by 
playing a series 
of match-three 
games. Yeah, we 
know, there’s 
not much of a 

connection between all the elements, but at least it’s different.
Fashion Fable’s 60 levels get harder as you advance. You 

earn money by matching up coin pieces, and after each level, 
you go shopping for new clothes—cute skirts, hip jeans, even 
hats and shoes. There’s no clear connection between the 
match-three game and the Asha story, so if you’re a gamer who 
demands thought-out plots and cohesiveness, this isn’t for 
you. It’s for the match-three fan who doesn’t mind—and even 
welcomes—something unique. The games are fast-paced, and 
since the Asha plotline doesn’t interfere, you can zip through 
the fashion parts.

The bottom line.
Fashion Fable tries 
something unique 
in a tried-and-true 
genre. The plot may 
seem contrived, but 
the core of the game 
works well.
—Michelle Victoria

Let’s hope you match three better than you 
matched this hat, shirt, and skirt.

SOLID
RATED

GOOD NEWS: Challenging, well-paced levels. Cute.
BAD NEWS: The story doesn’t quite make sense, but 
are you really paying attention to it in the first place?

COMPANY: Creatrix Games
CONTACT: www.creatrixgames.com
PRICE: $19.99
REQUIREMENTS: Mac OS 10.2 or later

COMING SOON

Do You Sudoku?
People can’t get enough sudoku, the number puzzle game from 
Japan—just don’t confuse it with soduku, a disease you can get from 
rat bites. Ouch! Here are three places to get your sudoku fi x free.—MV

Sudoku Dashboard Widget  (www.sudokufun
.com/widget.php)  Now your fi x is just a F12 
key-press away!
Sudoku from Chevrolet Europe  (www
.chevroletsudoku.com/sudoku.html)  The 
European division of an American carmaker has 
an online version of the Japanese puzzle.
SudokuDan  (http://world.std.com/~dpv/
sudoku/)  This app helps you create (and solve) 
sudoku puzzles that you can print.

S C H O O L  O F
DIGITAL ARTS 
& DESIGN

800.226.7625

3300 University Boulevard Winter Park, FL 32792

Financial aid available to those who qualify. Career development assistance.
Accredited College, ACCSCT.

fullsail.com
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because inquiring minds have the right to be inspired

Apple calls that status window thingy 
the iTunes Display Area.
WMV, PANTS ON FIRE
Hey, you said Flip4Mac would enable 
my Mac to play Windows Media video 
fi les, but it didn’t work—liar!

Oops; we neglected to mention that 
Flip4Mac is “working on” its Universal 

SNAP BACK, JACK
What’s up with the little curvy arrow 
on the right side of the iTunes status 
window thingy?
That’s actually a snapback icon—
recognize it from Safari’s URL bar? Click 
it to bring the currently playing song to 
the top of your browser window. Bonus: 

Salvador Dali, eat your soft heart out!

ERASE THE PAST
I had to reinstall Mac OS X (version 
10.4), and now I have this folder called 
Previous System 1 with some folders 
and Unixy-looking junk inside. Can I 
delete it?
That Previous System folder is your 
safety blanket; the Mac OS X installer 
provides different modes of installation, 
including one that preserves your 
preferences, settings, serial numbers, 
network information, and other 
important stuff. Once your newly 
installed system proves itself stable and 
not lacking any of the above-mentioned 
information, you’re free to delete any 
Previous System folders that you fi nd.

FREEZE FRAME
I dig the Genie and Scale tricks that 
windows perform when I minimize them 
to the Dock, but I can’t squeeze off a 
screenshot quickly enough to capture 
the effect. What’s the secret?
Slowing down the Dock’s minimizing 
effects is simple—just hold Shift while 
clicking the orange minimize button to 
see the effect in glorious slow motion. 

Most every networking company 
(D-Link, Netgear, and so on) 
makes some sort of Ethernet-to-
USB adapter—but we couldn’t 
fi nd one that ships with a Mac-
compatible driver. Lucky for you, 
crafty Mac hackers have created 
drivers for most known adapters. 
The drivers are free for the 
download (www.sustworks.com/
site/news_usb_ethernet.html), 

but study the compatibility matrix to 
fi gure out which driver matches your 
version of USB (1.1 or 2.0) and your 
Ethernet-to-USB adapter model.

STUFF YA LATER
All I wanted to do was compress a folder 
of things to install on the new iMac 
that I just ordered, but apparently, the 
compressing won’t be done for about 2 
million hours! What the heck?

We’ve been laughing at erroneous “time 
remaining” reportage for years, but 
the problem lags on. In StuffIt’s case, 
the company line is, “This is a known 
issue. However, it is only a cosmetic one. 
The software is otherwise functioning 
correctly.” For the record, the cool kids 
use Mac OS’s built in Control-click > 
Create Archive.

But wait! There’s more! Killing the Dock 
while a window is minimizing freezes 
the window midstream, leaving you 
free to snap screenshots (Command-
Shift-3) or even work in the window 
(be warned, though, that your cursor 
doesn’t get the gag and behaves as 
if the window hasn’t changed). To 
perform this fi shy feat, fi rst launch the 
Terminal (/Applications/Utilities) and 
prepare the command: Type killall 
Dock but don’t press Return to execute 
the command yet—fi rst go back to 
the window you want to capture and 
hold Shift while clicking its minimize 
button. As the window slowly changes 
shape and slides off the screen, you’ll 
have plenty of time to switch back to 
the Terminal and hit Return, which 
quits (and automatically restarts) the 
Dock, leaving your window partially 
minimized.

POOPY PORT
My PowerBook’s Ethernet port crapped 
out, and apparently, the fi x is a new 
motherboard. Can I reroute an Ethernet 
connection through the USB ports?

WMV, PANTS ON FIRE
Hey, you said Flip4Mac would enable my 
Mac to play Windows Media Video fi les, 
but it didn’t work—liar!
Oops; we neglected to mention that 
Flip4Mac is “working on” its Universal 
Binary release to support Intel-powered 
Macs. Until that’s released, try using 

Popwire’s UMV-9 Component (free, 
www.popwire.com). If you pony up for 
the pro version ($49.95) you can even 
create your own WMV content.

DL DIRECT
I have a long list of fi les to download. 
How can I quicken the process?
Just type or paste the download URL 
directly into your browser’s URL bar, or 
open the Downloads window (in Safari 
you’ll fi nd it in Window > Downloads; 
in Firefox it’s Tools > Downloads) and 
paste in a link to start downloading 
immediately.

UNLOAD
OK, now that I’ve quickly downloaded 98 
fi les, how do I fi nd specifi c ones?
Control-click an item in your Downloads 
window and select Show In Finder (Safari) 
or Open 
Containing 
Folder (Firefox); 
Safari users can 
click the little 
magnifying 
glass icon to 
jump right to 
the associated 
download.
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Bonus: Click the reload arrow to 
resume a halted download.

That’s 230,982 years, in case your 
calculator’s on the fritz.
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HOW TO 61No whining—
anyone 
can do this!

It’ll take some 
effort, but you 
can do it.

This stuff’s 
for the pros.

DIFFICULTY
RATINGS 

iDVD 
iDVD 6’s Media Browser is cool, but I want to 
use pictures that aren’t in my iPhoto Library. 
Can I get them into the Media Browser 
without importing them into iPhoto?
You sure can. Assemble the photos you 
want in a folder and drag the folder into 
iDVD’s Media Browser—just make sure 
you click the Photos tab fi rst.

SAVE
When I save Submit technical questions 

or helpful tips directly 
via email (askus@macaddict.com) or c/o 
MacAddict, 4000 Shoreline Ct., Ste. 400, 
South San Francisco, CA 94080.

lightning strikes, and other untold harms. 
If you’re scared enough, simply avoid 
downloading WMV fi les in the fi rst place.

SIDEBAR SHENANIGANS
I dragged the Network icon out of my 
Finder window’s sidebar; the little poof 
was cute, but how do I fi x my sidebar?
Open Finder > Preferences, select Sidebar, 
then use the check boxes to add or remove 
items from the sidebar. Bonus: The toolbar 
at the top of Finder windows is even more 
customizable; select View > Customize 
Toolbar and drag what you want into the 
toolbar area. You can add anything from 
the Desktop: fi les, folders, apps, whatever.

a document, some apps let me save 
anywhere on the Mac, but some only 
offer a list of places to save it. What 
gives?
That’s what the spiffy little blue arrow 
next to the Save As text fi eld is for; 
click it to morph the truncated Save 
dialog into fully navigable Finder-
esque window. Bonus: The short list 
shows any directory that you add 
to Finder windows’ Sidebar, so you 
can easily add some of your favorite 
dumping grounds to the short list.

WMV, VIRUS FREE
Is it safe to launch a WMV fi le of 
unknown origin? If not, can I protect 
my Mac so that I can watch the video 
without fear of a virus contamination?
We’ve never heard of an actual virus 
traveling via WMV, but we’ve learned 
never to say never. There are ways a 
malicious hacker could use a WMV fi le 
to hijack a Windows machine; however, 
the problem isn’t the WMV fi le itself, but 

rather vulnerabilities in Windows and 
the Windows Media Player that the fi le 
might exploit—by taking you to a Web 
site full of destructive, automatically 
installing code, for example.

So at this moment, we’ll say no, you 
won’t catch anything by playing strange 
WMV fi les on your Mac, but that could 
change at any time. Regarding fear: In 
computing (as in life) there’s always 
some possibility of viral infection, 

Now that’s a well-dressed toolbar!

MENU HOP
In singing the praises of using the Tab key 
to jump from fi eld to fi eld on Web-based 
forms, you forgot to mention that when 
you’ve tabbed to a pull-down menu, typing 
the fi rst few letters of the item you want will 
move your choice to the head of the menu.
Roger that—and sometimes it takes 
a moment for your keyboard entry to 

register with 
the menu, so 
be patient.

YOU’RE SCREWED
You know that screw that holds a G5’s 
PCI card or slot cover in place? How do 
I avoid dropping the little bast’id down 
into the Valley of Lost PCI-Slot Screws?
After shaking dropped screws out of G5 
cases one too many times, we learned 
to use a dab of glue from a glue stick to 
keep the screw on the screwdriver while 
delivering the former to its designated 
hole. Magnetic-tipped screwdrivers 
are a sexier solution, but willfully 
inserting even the meekest magnet into 
a computer’s case is widely regarded as 
one of the dumbest things one can do.

UNIX UNIVERSITY

Niko Coucouvanis never met a Mac he couldn’t 
beat into submission, yet he knows that one 
will someday replace him.

Although it’s utilitarian by defi nition 
and wears its no-frills-ness like a badge 
of honor, the Terminal has some nifty 
tricks up its sleeve for those who haven’t 
yet earned the title of Unix Jock. As it 
turns out, there are a couple of ways to 
automate Unix commands based on the 
Terminal’s behavior. For starters, you can 
set a blanket command to execute every 
time you launch the Terminal application. 
Just select Terminal > Preferences, check 
the radio button labeled Execute This 
Command (Specify Complete Path), and 
enter a command in the text fi eld. You 

can type in a simple one, such as uptime
(for a report of how long your Mac’s been 
running) or who (to see if anyone is 
logged in), or you can run a preassembled 
script by typing in the path to the fi le. 

You can also use similar trickery to 
attach a command or script to a saved 
Terminal window, so the command(s) only 
automate when you open a specifi c TERM 
fi le (that’s Terminal-speak for a Terminal 
Window Settings fi le). On its own, a TERM 
fi le only specifi es Terminal windows’ 
settings—font and background color, 
buffer size, shell emulation, and other 

geeky goodness that you can set via the 
Terminal Inspector (File > Show Info). 
After tweaking a Terminal window’s 
settings to your liking, select File > Save 

As; in the resulting 
dialog, supply a 
name (somename.
term) and specify 
a command or 

fi le for the Terminal to autoexecute every 
time you open the fi le (somefi le.term). By 
default, Terminal saves your TERM fi les in 
user name/Library/Application Support/
Terminal; double-click a TERM fi le to launch 
it, or launch the Terminal and select File > 
Library to see a list of all the TERM fi les 
you’ve saved.

You can execute 
a command every 
time the Terminal 
launches...

RUN, TERMINAL, RUN
Is it possible to run a Unix command every time I launch the Terminal?

Look, Ma, 
no hands!

...or open Terminal windows with specifi c 
settings. Or both!



Handwrite, Right?1 First, grab a pen and paper and write out the whole alphabet—caps and 
lowercase—and if you’re serious about creating a complete font, include all 

the symbols, accented letters, obelisks, and so on. At the very least, include numerals 
zero through nine and common punctuation. As you write, keep in mind that you’ll still 
tweak the characters later with the software, but that’ll be easier if you plan ahead and 
draw your alphabet with the following guidelines in mind:
Be Consistent: Make your characters roughly the same size and draw them on a 
straight line.
S e p a r a t i o n: Give your glyphs enough breathing 
room, and ScanFont will accurately separate them 
for you, saving mucho time.
Media Matters: Create some style by using textured 
paper and/or a thick marker, a wax crayon, a razor-
sharp pencil, or fi nger paint to get unique results.
Scan Smartly: Set your scanner to 600 dpi for a 
smooth-edged scan.

62 HOW TO
make a font out of your own handwriting
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ON THE
DISC

ScanFont 4.0, TypeTool 2.0

Make a Font out 
of Your Own 
Handwriting
by Niko Coucouvanis

Mac OS X 10.4 ($129, www.apple.com)

ScanFont and TypeTool bundle 
($199, www.fontlab.com) 

Scanner (optional)

WHAT YOU NEED

W
riting by hand 
is nearly a lost 
art in this crazy 
computer 

age, so why not preserve 
your penmanship as a font on your Mac? ScanFont and 
TypeTool work in a plug-in/host-app relationship where 
ScanFont is an autotracer that converts your scanned 
handwriting (or clip art, 
photos, or even obsolete 
bitmap fonts) into vector 
outlines, which TypeTool 
then rolls into a functional 
font fi le. Here’s how to make 
your handwriting into a font 
with minimal fuss.

WORKFLOW: All 
you need to 
create or open 
a fi le, designate 
and separate 
the characters, 
then ship it off 
to TypeTool.

 

TOOLS: The selecting and drawing tools 
work as you’d expect; those four we circled are for 
creating and selecting cells (the upper two), splitting 
cells into two, and setting the font’s scale factor.

FONT WINDOW: This contains all of 
a font’s characters. When you create 
a new font, don’t be put off by the 
characters already in place—those 
are simply placeholders waiting to be 
replaced by your own glyphs.

GLYPH WINDOW: This is 
where you tweak characters 
individually, using toolbar tools 
or onscreen guides to edit, scale, 
and position your glyphs.

CELL: Each glyph 
occupies its own 
cell. You can quickly 
gauge a character’s 
baseline and 
kerning settings by 
studying its cell.

BASELINE: The blue 
line designates 
where characters 
will sit relative to 
the baseline—our 
slanty sample 
will require some 
baseline tweaking.

METRICS WINDOW: Highlight a glyph or 10 in the Font window, then 
select Window > New Metrics Window to tweak specifi c glyphs’ kerning 
and side bearings. When you’ve had enough, click the Auto Metrics 
button to easily set values for selected characters or for the entire font.

Font Anatomy 
Ascender: The part that sticks up above the X 
height (as in b).
Baseline: Where the characters sit.
Caps height: Tallness of uppercase glyphs and 
lowercase ascenders.
Character width: The overall width of a glyph plus 
its designated breathing room (kern).
Descender: The part that sinks below the 
baseline (as in p).
Glyph: Used interchangeably with character—a, 
B, 1, ?,  and * are all glyphs.
Kerning: The spacing between glyphs in a font.
Leading: Pronounced ledding, it’s the font-
defi ned vertical space between lines of text.
Side bearings: The padding between the actual 
glyph and the character width; TypeTool lets you 
tweak both the right- and left-side bearings.
X height: Tallness of most lowercase glyphs.

As in most creative digitizing endeavors, the better 
the source material, the better the fi nal product.

IMAGE WINDOW: 
This is ground 
zero, where you 
use the tools to 
tweak your font’s 
characters en 
route to TypeTool.



Scan-o-rama2 ScanFont is a little behind the Mac OS X curve—you 
can’t scan directly into it, so you’ll have to scan into 

Photoshop or your preferred image-editing app and open the 
resulting fi le in ScanFont. (OS X’s Image Capture supports many 
scanners as well.) Or, if you’re handy at drawing with a mouse 
(or a graphics tablet, if you’ve got one), select File > New and 
knock yourself out; you can use ScanFont’s drawing tools or 
import fi les in formats including TIFF, PNG, and any QuickTime-
supported format. Once you’ve scanned your scrawl, open it 
in ScanFont by clicking the Open button, or by selecting File > 
Open and navigating to your saved image fi le.

Initial Tweakage3 Before breaking your alphabet into individual character 
outlines, take a moment to fi ne-tune the whole block. Use 

the selection tool to isolate glyphs and drag them into formation 
(or nudge ’em by holding Shift and pressing the arrow keys). 
Imagine a grid of straight lines and give each glyph uniform 
spacing and baselines—you’ll still fi ne-tune later, but this 
preparation ensures a better outline trace. To tweak individual 
glyphs, highlight one with the Magic Wand, Lasso, or Marquee 
tool, select Edit > Transform, and pick your poison (Scale, Slant, 
Rotate, and so on); you can fake an italic version of the font by 
slanting the glyphs (yes, individually), but it’s best to do that later 

in TypeTool. When 
your letters seem 
well aligned and 
spaced, click the 
Separate button 
or select Cells > 
Separate Shapes 
(Command-U).

Keep ’Em Separated4 If you’re not satisfi ed with the fi rst separation, select 
Edit > Undo (Command-Z) and try again with different 

settings (the defaults worked peachily for us). To trim the cells 
of any excess space, select Cells > Detect Bounding Boxes, then 
select Cells > Baselines > Set To Cell’s Bottom. Finally, peruse 
your characters for any cell oddities (adjacent letters sharing a 
single cell, for example). Use the Cell Selector tool to select the 
cells (Shift-click to select multiple cells), and press Delete—the 

underlying glyphs 
remain in place. 
Now select the 
Defi ne Cell tool 
and draw the 
replacement cells.

Trace Elements5 Finally, click the Export button or select Cell > 
Place Into Font. In the Export dialog, keep the default 

naming option, check the Export All Cells box, and click OK; in 
the following dialog (Trace Options), the default setting gave 
us good results, but this is where art takes over. Depending on 
your glyphs and your intentions, try the default presets for a 
tighter or looser outline. The screenshot below illustrates the 
loosest possible trace of the top of a Sharpie-drawn capital 

A. When you’re 
satisfi ed, click 
OK, and in the 
fi nal dialog, 
select Place Into 
New Font and 
click Export.
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Our scanned block 
alphabet needs 
some help.

Exit to TypeTool6

Tweak characters 
now to reduce 
tedium later.

After you export from ScanFont, TypeTool greets you with a new Font window, 
prepacked with samples of all the glyphs you’d need to create a full font: 

uppercase and lowercase letters (26 of each), numbers, symbols, punctuation, accented 
letters—even ligatures. Your handiwork is appended at the bottom of the template, so 
click and drag to select the glyphs you just imported, then drag the lot up and drop them 
in place of the placeholder glyphs (drag your A, for example, onto the template’s A—it’s 
easier than it sounds). With all of your characters still selected, select Windows > New 
Metrics Window.

With the fat 
trimmed and 
the baselines 
aligned, you’re 
ready to export.

This is where 
the science of 
fontography gives 
way to art.

This action shot shows how the 
placeholder alphabet changes color when 

we drag our characters over it.



The NewerTech miniStack™ V2 - Powered USB2 
Hub with 3 Ports; Powered FireWire Hub with Two 
Available Ports. 

Serving the Computer Universe since 1988
Visit MacSales.com/storage 800.275.4576

MA_10_06  Other World Computing, Newer Technology, a part of New Concepts Development Corp., 1004 Courtaulds Dr., Woodstock, IL 60098
Prices, specifications, and availability are subject to change without notice. Items returned within 30 days may be subject to a restocking fee.  No return will be accepted without Return Merchandise Authorization number. 

Visit our website to check 
out our full line of external 
storage solutions and 
other accessories.

*Test performed with 250GB miniStack solution. Similar results with 80GB to 750GB models
**80GB model covered by 2 Year NewerTech Full Solution Limited Warranty + 1Year Additional(Total 3 Years) Hard Disk Manufacturer Warranty; 160GB to 750GB covered 

by 2 Year Full Solution Limited Warranty + 3 Additional Years(total 5 years) Manufacturer Warranty on the Hard Disk inside.
Mac mini is a trademark of Apple Computer Inc.

Go from Clutter...

MacSales.com/storage

™V2
miniStack™

29.33 seconds
Stock Drive 

44.67 seconds

500MB Copy Test*

Storage 
solution + 

connection point
for virtually ANY 
computer with 

USB2 and/or 
FireWire!

The cleanest way to add up to 750GB of external drive 
storage and integrated FireWire & USB2 hubs to your Mac!

• Home Entertainment • Music        • Bootable Data Storage  
• Audio/Video Certified • Graphics  • Backup
• Complete Solutions with EMC Retrospect, Intech Speedtools

Utility Suite, FW & USB2 Cables included
• NewerTech industry leading Full 2-year Solution Warranty +

Additional 3 Years (5 years total!) for the HD inside**!

FireWire + USB2 Solutions
Capacities Price

0GB 'Add Your Own Hard Drive' $79.95

80GB 7200RPM 2MB Cache $124.99

160GB 7200RPM 8MB Cache $139.99

250GB 7200RPM 16MB Cache $167.99

320GB 7200RPM 16MB Cache $195.00
400GB 7200RPM 16MB Cache $279.99

500GB 7200RPM 16MB Cache $295.00
750GB 7200RPM 16MB Cache $539.99

500GB 7200RPM 16MB Cache
750GB 7200RPM 16MB Cache

DEAL!

Price

Up to 
750GB!

320GB 7200RPM 16MB Cache
400GB 7200RPM 16MB Cache

DEAL!

Extra
Ports!

The perfect 
companion 
for any Mac!

Voted Best
Top Product

Apple Cinema Display, pictured Camcoder, Hubs, Separate FireWire Hard Drive, Keyboard, Mouse are not include with the miniStack

USB2 Only Model also available From $54.99

High-performance, highly reliable, PLUS a space 
saving/clutter reducing integrated Hub.

To Clean!
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Enter the Metrics7 TypeTool’s Metrics window is where you set the font’s 
basic metrics and kerning; the window should open 

in Metrics mode, but click the M icon anyway. Now click the 
gemstone-looking icon to bring up the Automatic Metrics 
Generation dialog, select Whole Font from the fi rst pull-down 
menu to tweak the metrics wholesale, and then decide how 
much white space you want surrounding each glyph. As with 
the autotracer, this step is more art than science, so experiment 
with different metrics (preview your settings in the main Metrics 
window) until you’re satisfi ed. Click the K icon to set your font’s 
kerning—again, click the gemstone to summon the Auto Kerning 

Generation window 
and experiment with 
different values until 
you like what you 
see in the preview 
window. 

Tweak for Flavor8 Even after sweating over your Sharpie for hours to get 
the characters just right, you’re bound to fi nd some little 

things that need fi xing. That’s what TypeTool’s Glyph window 
is for; double-click any character in the Font window to launch 
it in the Glyph window—or to launch a blank Glyph window if 
you started with a blank font and haven’t added the respective 
character yet. Now simply use the Edit tool to push and pull the 
vector outline’s points and curves to fi x fl aws or add fl air; again, 
we’ll leave the art direction up to you. Try your luck at drawing 
numbers and punctuation with TypeTool’s drawing tools, or go 
back to the drawing board (pun intended) and scan them in.

10 To use your new 
font, fi nd the 

font fi le you generated in the 
last step and double-click it 
to launch OS X’s Font Book, 
which will show you a preview 
of the font and offer to add 
it to your fonts. We found 
that restarting the Mac was 
sometimes necessary to get 
our apps to acknowledge the 
new font.

Use It or Lose It

Niko Coucouvanis took many a nun’s knuckle-rap for his lackadaisical 
attitude toward legible handwriting—but who’s laughing now?

Auto Metrics is way 
easier than manually 
dragging or typing in 
side-bearing values.

Warning: Once you start messing with individual character outlines 
(before is on the left, after on the right), you might never stop.

Add Info9 Now we’ll give our font its walking papers. Select File > Font Info (Command-F). Start with the basic Names and Copyright, 
keeping in mind that this isn’t just gratuitous legalese—this information affects how other applications and OS X’s Font Book 

treat your font, so don’t get too clever with the wacky naming. If you’re 
overly ambitious, you’ll notice the check boxes that identify the font as 
Italic or Bold—sorry, but checking the boxes won’t embolden or italicize 
any glyphs. You’d have to do that manually in TypeTool, then come 
back to Font Info and check the respective boxes, and then export the 
different-style typefaces into a Font Suitcase. If you’re that ambitious, 
it’s just a matter of repeating this entire tutorial a few times. If you’re lazy 
like us, you’ll take the path of least resistance: Select File > Generate Font 
and export a TrueType font—you can apply bold, italics, underlining, and 
so on via your word processor—or 
see “Bulk Transform” for the easy 
way to stylize your base font.

In the interests of truth in naming, we 
dubbed our font “Chicken Scrawl.”

Ta-da! Here’s our 
crude font in action—

can’t you just smell 
the retro charm?

Bulk 
Transform 
You can make some global 
tweaks to your glyphs—slanting 
every letter 19 degrees to 
create a faux italic typeface, for 
example—via the Transformation 
dialog. Select a cell or several 
in TypeTool’s Font window and 
select Tools > Transform. In the 
resulting dialog, pick your poison 
from the menu (Contours, Hints 
and Guidelines, or Metrics) and 
tweak the values below to modify 
all of the selected glyphs.



Filter First1
Filter Frequently2

Generator? I Don’t Even Know ’Er!3 He Who Masks Last...4
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Launch Image Tricks and either click the Open icon, 
select File > Open, or simply drag an image from the 

Finder (or iPhoto) into Image Tricks’ main window. Click the 
Filters tab in the upper-left corner and scroll down the list to 

a filter—we’ll start with 
Hue Adjust to tweak our 
subject’s complexion. We 
slid the slider to 2.0 to 
make Ellen a little green 
around the gills. When you 
get the effect just right, 
click Apply to commit.

Image Tricks’ real mayhem begins when you start 
layering multiple effects on your photo. Already tinted 

green, Ellen needs a little Bump Distortion. Since this effect is 
more complex than a color adjustment, it provides more sliders, 
and its crosshairs icon indicates that you need to use the cursor 
to place the filter’s effect wherever you want it in the picture. 
By twiddling the Radius and Scale sliders and repositioning the 

focal point, we can make 
Ellen a big-brained space 
alien or a slack-jawed 
Shrek. Again, click Apply to 
seal the deal.

Image Tricks’ other trick is generating vector art—an 
acquired taste, certainly. Like the filters, different 

generators provide different controls. Circle Interference, shown 
below, lets you pick Circles or Stars and set the Resolution, 
Size, and Factor. Tweak the sliders until you like the results 
and then click the Edit button to bring your new image into the 
Filter gallery for some filter-effect fun. Note that some of the 
generators require rendering before you can move on—in such 

cases, click the Render 
button. Whether or not 
you pile on effects, select 
File > Save As when 
you want to save your 
creation.

You also have a set of masks at your disposal—various 
gradients, frame borders, corner illuminators, and more. 

In the screenshot, we’ve artsied up Alien Ellen with a dramatic 
border mask. To use the masks (they’re only available in Filter 
mode), click the Masks icon at the bottom of Image Tricks’ main 
window and pick a mask from the list. To remove a mask, simply 

click any other 
mask on the list, 
or uncheck the box 
labeled Mask (it’s at 
the top of the mask 
list). As before, save 
your composition to 
lock in the mask.

ON THE
DISC

Image Tricks 2.2

Tap into Core Image effects, no Photo Booth required.

The effects don’t stick until 
you click the Apply button. Ellen, alien, or Shrek? It all 

depends on how you tweak 
the tools.

You could lose days staring 
into the generated Circle 
Interference—well, we 
could, anyway.

Finally, add a mask to 
rein in the edges.

Mac OS X 10.4 ($129, www.apple.com)

Image Tricks (free, www.belightsoft.com)

Digital images upon which to wreak havoc

WHat You NEED

A
pple is so cruel, creating sexy software like 
Photo Booth, then distributing it only with 
the latest, iSight-equipped Macs. Here’s 
how to tap into the same 

Core Image filters used by Photo 
Booth—without emptying your 
wallet at the local Apple Store.

Trick Out Your Photos
by Niko Coucouvanis
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Bonus: You can study for geography 
class at the same time!

You can use a knife to bore 
out the magnet holes, but a 
power drill is quicker—and 
more entertainingly 
dangerous.

Walk the Outline1
Cut a Rug2

Magnetize It3 Glue Glut4
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Start with a sturdy hardcover book that’s thicker than 
your iPod and big enough to accommodate the ’Pod with 

at least a 1/2-inch margin all the way around (ours is, in inches, 
about 4 by 6 by 1). Separate the pages of your book into two 
parts: the bottom, which needs to be 1/8 inch thicker than your 
iPod, and the top, where you should leave at least 1/8 inch or so 

of pages to conceal the magnets. 
Use a pen to trace your iPod’s 
outline on the bottom section of 
the book; don’t forget to trace the 
earbud plug and cord.

Before you start stabbing the book, figure out where in 
the book’s pages the back of the iPod will be, and put a 

sheet of plastic or metal there to stop the blade from cutting any 
deeper. For optimal slicing and dicing, line up a ruler with the 
outlines you drew in step 1, and have at it with the hobby knife. 

If you have a clamp available, use it 
to keep the book steady as you cut. 
You’ll probably want to remove the 
extra paper as you go, but whatever 
your preferred technique, this is 
tricky, delicate work, so take your 
time—and watch your digits.

To keep the book closed, we’ll embed two pairs of 
rare-earth magnets into the margins. Don’t worry; the 

magnets are strong enough to keep the book closed, but not 
strong (or close) enough to mess with the iPod’s hard drive. 
Mark both outer corners (on the inner top and bottom of your 
new case) about 1/2 inch in from both edges. Before cutting the 
holes, flip a page or two out of the way—you’ll glue them down 
later to conceal the magnets. Cut or drill deeply enough in each 
corner to fit a magnet, and before you insert the magnets, check 
the polarity to make sure that they stick together when you 
close the book. Drop a bit of glue and a magnet into each hole, 

and glue down the covering 
pages that you didn’t cut.

To keep the pages together, apply liberal amounts of 
glue to the interior edges of the iPod area. Smear the 

glue all around with a popsicle stick or your finger. To dry the 
glue, put sheets of paper or plastic between the top and bottom 
sections of the book to prevent stickage, and leave the case 
under a couple of heavy books overnight. If some of the pages 
are loose, you can cut slits into them and pour in some glue to 
keep the pages together. For the final touch, glue a swatch of 
black velvet into the iPod’s cradle. Now lay your iPod in the case 
and enjoy your music clandestinely!

Don’t be afraid to get 
messy—the glue is best 
applied with your finger, 
and you’ll need quite a 
bit of it to keep the pages 
solidly bonded.

Geography  
class sounds  
better with this  
hacked-up atlas.

Leave a little extra space if 
you want to pad your ’Pod 
with a velvet case liner.

Any iPod ($69 and up, www.apple.com)

Small hardcover book

Four 3/16-inch diameter neodymium (rare-earth)  
magnets ($.05 to $.19 each, www.kjmagnetics.com)

X-Acto knife or other sharp blade  
($2.99, www.dickblick.com)

Aleene’s Tacky Glue or similar adhesive  
($3.29, www.dickblick.com)

Optional: Dremel tool, ruler, clamp, black velvet lining

What YOu Need

S
itting in class as your professor drones on about world 
geography, you remember that you haven’t heard the new 
Phoenix album yet—and it’s on your iPod. To spare you such 
heartache, here’s how to hack a boring ol’ book into an iPod 

case so stealthy that your prof never even heard it coming.

Make an iPod Book Case
by Brian Moore
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Mercury Elite Pro AL

Single Drive

FW 400 + USB2 (80GB to 750GB) From $114.99

FW 800/400 (80GB to 750GB) From $129.99

FW 800/400 + USB2 (80GB to 750GB) From $139.99

Quad eSATA FW 800/400 + USB2 (250GB to 750GB) From $199.99

RAID

Stripe FW 800/400 (160GB to 1.5TB) From $209.99

Mirror FW 800/400 (250GB to 750GB) From $399.99

0+1 FW800/400 (500GB to 1.5TB) From $679.99

On The Go

FW 800 + USB2 (40GB to 160GB) From $139.99

FW 400 + USB2 (40GB to 120GB) From $124.99

FW 400 (40GB to 120GB) From $115.99

USB2 (40GB to 120GB) From $99.95

MacSales.com/storage

MacSales.com/memory

MacSales.com/harddrives

MacSales.com/osx

MA_10-06 Prices, specifications and availability are subject to change without notice. Items returned within 30 days 
may be subject to a restocking fee. 
No return will be accepted without Return Merchandise Authorization number. 

Serving the Computer Universe since 1988
Visit MacSales.com 800.275.4576

MacSales.com/superdrives

The RIGHT Memory in stock for Apple's Intel Macs. 
ALL OWC Memory Guaranteed and Backed 
by a Lifetime Advance 
Replacement Warranty. 

miniStack

FW 400 + USB2 (80GB to 750GB) from $124.99

USB2 (80GB to 500GB) from $109.99

ADD 
PORTS!

MacSales.com/storage

Mercury Elite Pro Classic

FW 800/400 + USB2 (80GB to 500GB) From $149.99

FW 800/400 (80GB to 500GB) From $139.99

FW 400 + USB2 (80GB to 500GB) From $119.99

USB2 (80GB to 500GB) From $95.99

OSX Tiger 10.4
Full Install Set

$89.00

Apple iLife ‘06
Share the magic

$79.00

for PowerMacs, 
iMacs, & eMacs
up to 750GBs

From $47.99

for PowerBooks 
& iBooks
up to 100GB 7200RPM NoteBook 
Performance

From $63.99

Internal Hard Drives

Software

for MacBook & MacBook Pro
120GB 5400RPM $148.99
100GB 7200RPM $179.99
160GB 5400RPM $259.99

SuperDrives

for G3/G4/G5 Desktop & Tower Macs From $42.99
for PowerBook G4 From $119.99
for iMac G5 From $129.99
for Mac mini From $119.99
for G4 Cube From $129.00

External FireWire/USB2 
Solutions From $99.95

Memory

for both MacBook Pro’s, iMac 
Intel, & Mac mini Intel
up to 2GBs
From $99.99
for all PowerBook G4s; 
iBook G3/G4s
up to 1GB (1024MB)
From $26.99

for all PowerMac G4s, eMac 
G4, and iMac G4
up to 1GB
From $24.99
for PowerMac G5s and 
iMac G5s
up to 4GB Matched Pairs
From $45.99

NEW! for Mac Pro
up to 16GB Matched Set (2GB Modules x8)
From $559.00

Mercury Elite-AL Pro FireWire/USB Drives
Single and Dual RAID up to 1.5TB (1500GB). Plug-and-Play. 
Ready to transfer at up to 800MBit/Sec.
From $114.99

On-The-Go FW400-800-USB2 2.5” Solutions
Up to 160GBs of Performance Storage
that fits in your Shirt Pocket!
From $99.95

miniStack™ V2  FireWire & USB Drives
Solutions with Integrated FW/USB or USB ONLY Hubs
From $99.95

The Mercury Elite Pro Classic FW400-800-USB2
High-Performance 7200RPM Drive with 2MB, 8MB or 16MB data 
buffer gives you maximum storage in an ultra-portable design.
From $95.99

Do-It-YOURSELF
0GB 'Add Your Own Hard Drive' 

MacSales.com/tech

800.275.4576

TRUE APPLE 
QUALIFIED 
PRODUCT!
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M-Audio®

Ableton Live 5 ....................$249
Pro Tools 7 M-Powered ......$149

Microsoft®

Office 2004 Student/Teacher ....$139

Adobe®

Acrobat Pro 7............Save 69%
Photoshop CS 2.........Save 52%
Dreamweaver 8.........Save 53%
Studio 8 ....................Save 71%

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®

Creative Suite 2
Save! 67%
Order Today!
Design with the Best!

Quark®

QuarkXpress 6.5
Save! $756
Only!  $189.95

Make Amazing Projects!

Wacom®

Intuos3 6x11”
Save! $50
Only!  $319.95

Create Digital Artwork!

Alias®

Maya 7 Unlimited
Save! 85%
Only!  $389.95

Become a 3D Animator!

We carry many of the products reviewed in this magazine!
Softpress Freeway 4 Pro ................$179 Kodak EasyShare One ....................$449
M-Audio Podcast Factory...............$139 Epson PowerLite 76c......................$949
Sorenson Squeeze Compression Suite..$199 Pantone huey ...................................$69

Give us a call anytime!  1-800-294-4035

Hey Parents!
“You are eligible to buy for your

students at home or away at school.”

NewTek®

LightWave 3D 8.5 .................$195

Sibelius®

Sibelius 4.................................$239
Auralia 2.1.................................$89

FileMaker®

FileMaker Pro 8 ..................$149

Corel®

Painter IX.5...........................$95
CorelDRAW Graphics Suite X3 ...$95



MAC TRADE-INS WELCOME!MAC TRADE-INS WELCOME!

MEMORYMEMORY MACS
& MORE!
MACS
& MORE!

Lifetime Warranty RAMLifetime Warranty RAM HARD DRIVE SPECIALSHARD DRIVE SPECIALS

®

since
1994

MacSolutions.comMacSolutions.com
Ad code 811-6

800•873•3726800•873•3726
11933 Wilshire Boulevard, West LA, CA 90025 
Phone: (310) 914-3200  Fax: (310) 966-4433
University & School P.O.’s Welcome.  Prices subject to change without notice. 

,,

The memory market is extremely volatile. Prices are always 
changing. Please call or check our web site for current pricing.

AMAZING DRIVE VALUES!
Serial ATA drives for G5/Mac Pro
750gb 7200rpm 16mb cache $466
500gb 7200rpm 16mb cache 249
250gb 7200rpm 8mb Cache 89
ATA Drives for G4
320gb 7200rpm 8mb cache $109
250gb 7200rpm 8mb cache 89
120gb 7200rpm 8mb Cache 79
Serial 2.5” for MacBookPro + Intel Mini
160gb 5400rpm 8mb cache $249
100gb 7200rpm 8mb cache 199
120gb 5400rpm 8mb cache 179
100gb 5400rpm 8mb Cache 149
2.5 ATA Drives for PwrBks/iBooks/G4 Mini
160gb 5400rpm $239
120gb 5400rpm 159
100gb 5400rpm 129

ALL MEMORY ON SALE!!!
667 MHz DDR2 ECC for Mac Pro NEW!!

4gb Kit 2x2gb $789
2gb Kit 2x1gb $389

5300/667 - All Intel Macs
1gb 667 SoDIMM $76

4200/533 For DualCore G5
4gb Kit 2x2gb $419
2gb Kit 2x1gb $159

4200/533 Powerbook G4 Hi-Res
1gb 533 $76

3200/400 For Dual Prossesor  G5
2gb Kit 2x1gb $159
1gb Kit 2x512mb 79

2700/333 Powerbook G4
1gb 533 $95

PowerMac G4 PC133
256mb/512mb $29/$69

Note: Prices are subject to change. Quantities limited to stock on hand. School P.O.’s welcome.                                MA809

800-462-2160800-462-2160

.COM

We’ve got ’em!

www.

We’ve got all the memory solutions you need for:
Mac Pro • MacBook Pro • Power Mac

PowerBook  • iMac • iBook  
eMac • Mac Mini

Samsung memory available!

2gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro $379
1gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro $189
1gb 5300-667 for MacBookPro/Intel Macs $79
1gb 4200-533 for Dual Core G5 $79
1gb 3200-400 for Dual Processor G5 $89
1gb 2700-333 for PowerBook G4/iBook G4 $99
* FB = Fully Buffered

You need ’em?

NEW!!NEW!!

NEW!!NEW!!
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Mac + iPod Parts & Upgrades

We’ve got your 
(iPod’s) back.

1-866-61-FIXIT

do-it-yourself Mac & iPod Parts
free online FixIt Guides
thousands of parts and upgrades

iFixit.com

Parts & Accessories for your Mac + iPod
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Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 
lpresser@macaddict.com

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

New Higher Resolution
G4 PowerBook

Docking Station

         G4 PowerBook 
New Higher Resolution 

Docking Station

         
G4

Now

Shipping!

MacBook Pro and MacBook Coming
Soon!



� Fast, advanced, proprietary techniques.
� All operating systems; Mac, Windows, OS/2,

Netware and UNIX.
� All storage devices including SAN, RAID 

and NAS systems.
� Instantly retrieve recovered data 

with DataExpress™.
� Recommended and certified by all 

hard drive manufacturers.
� Government Contracts
� Featured on MacAddict,MacWorld, 

CNN, BBC and others.

MacAddict 3.5˝ X 2.3˝

“We Can Save It!”

7 great reasons to choose DriveSavers:
DATA RECOVERY: 800-440-1904

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949  INTL: 415-382-2000  
Visit DriveSavers at www.drivesavers.com

“Restoring Data 
and Peace of Mind 

Since 1985”
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Thought you might enjoy this picture from the Cannon 
Beach Sand Castle Contest in Oregon.—Leslie Wildesen

RINGTONE 
TROUBLES
In the Aug/06 issue you 
described how to create a 
ringtone using a RAZR and 
iTunes. I followed all of the 
directions, but at the last 
step where you ask the 
Mac to fi nd the phone, it 
gives me the message “0 
devices found,” even though 
I have Bluetooth turned on 
both on the Mac and on 
the phone. What’s up? I’ve 
heard that the various cell 
phones companies disable 
a lot of the features that the 
manufacturer provides on 
its phones; maybe that’s 
the case here? I’m with 
Verizon.—Kevin Denman
A lot of people wrote in 
about this, and you’re right: 235 respondents

A HAPPY CAMPER
I want to nominate Red 
Marble Games’ customer 
support for an award. I 
fi nally got around to buying 
FlipWords, which was a trial 
on one of the MacAddict CDs. 
I love the game, but I couldn’t 
get the purchase code to 
work. I would type it in, then 
get caught in an endless loop 
of “Please enter your code” 
or “Please buy the game 
now.” I spent a month trying 
to fi gure out what I was doing 
wrong before giving up and 
emailing them. Two hours 
after I sent the email, they 
had fi xed the problem. I know 
this is the way customer 
service should work, but I’m 
always surprised when it 
does.—Deb Montague
I’m skeptical anytime 
someone gets an award for 
fulfi lling what is actually a 
basic duty—but since you 
asked so nicely, here goes: 
Red Marble Games, you’re 
doing a heck of a job.—Max 

D’OH!
Your “Boot Different” article 
(Jul/06, p20) missed an 

old, reliable, and important 
boot technique. After I set 
up a couple of external 
FireWire hard drives, my 
Mirrored Door Power Mac 
G4 running OS 10.4.6 hung 
at the blinking question 
mark, refusing to boot into 
any of the three modes 
you described (Safe Boot, 
Verbose Boot, Single User 
Mode). I could start up from 
the Mac OS X CD and restart 
while holding the Option 
key, but the G4 could only 
see the OS X CD, and I could 
not select a hard drive to 
start up from. So I resorted 
to the time-honored “restart 
while holding down the 
Option+Command+P+R keys” 
method to, as we used to 
say, zap the PRAM. I held it 
down through three restart 
chimes, and then the G4 
started up normally. If I had 
zapped the PRAM fi rst, it 
would have saved me a full 
day of sweating bullets.
—James K. Morgan
Your tip, James, is PRAM-
tastic!—Max

WE GET IT
Nobody gets me! Is there 
anyone reading your 
magazine who wouldn’t 
understand this license 

plate? I live in Brighton, 
Michigan, and so many of 
my friends who know I am 
a Mac addict still don’t get 
this plate! Then there are 
the forgivable peecee users 
who ask me and wander off 
with quizzical looks on their 
faces. Any suggestions as 
to how I should modify this 
plate this January are most 
welcome!—Scott Seitz
Don’t change a thing! If your 
friends don’t understand 
the coolest license plate 
ever, maybe they need their 
RAM expanded.—Max

I hope that iPod has a waterproof case.

Now that’s a classy ride.

tell us how you really feel

Survey Says
Here are the results 
of our July 2006 
survey. Check out 
www.macaddict.com 
each month for a new 
online poll.

WHAT FEATURES WOULD YOUR LIKE TO 
SEE IN THE NEXT VERSION OF MAC OS X, 
AKA LEOPARD? 

10% An easier way to 
choose which printer 
drivers and languages get 
installed.

18% Spotlight 2.0—a version 
that doesn’t suck.

1% A Windozian Start menu 
and Taskbar.

5% The return of OpenDoc.

25% Built-in, 
automated, 
idiot-proof 
backup.

34% 
An improved 
Finder.



CONTESTANT INFORMATION  
Full Name:

Address:

City:                                                               State:

Zip:

Email or telephone:    

Congratulations to Allen Huffman—
aka Captain Boyd, Legendary Pirate, 
from the Pirate Comedy Show (http://
piratecomedyshow.com)—who 
won a Rain Design iWoofer ($129, 
www.raindesigninc.com) for his 
admittedly self-referential caption.

Winner!

vv    t
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Win an iLuv Video System!
How cool is this? The iLuv i1055 Portable DVD Player ($249.95, 
www.i-luv.com) includes a dock for your 30GB or 60GB video-
capable iPod, sports a 7-inch widescreen LCD display, and will 
play DVDs, VCDs, and both audio CDs and MP3 CDs. How do you 
get your hands on this sleek bit of techno-wizardry? Just write 
the best caption to the image below.
Only one entry per contestant.

79

How do you identify a music 
pirate? Look for the iPatch.

Verizon has disabled the 
MP3 ringtone feature on 
its phones (we did get it to 
work just fi ne on Cingular 
RAZRs, though). Wired
.com’s Listening Post blog 
has been covering this 
issue, and its readers 
have suggested some 
workaround hackery, so 
head to http://blog.wired
.com/music for more.—Max

HEP CAT
I thought you would get a 
kick out of this. Seems like 
everyone’s a music critic 
these days.—Keith E.
I can understand his 
reluctance to use a mouse, 
but I’m not sure drag and drop 
works quite like that.—Max

FREEBIE-JEEBIES
In the sidebar “There Is Free 
Lunch!” (Aug/06, p31) you 
list Crystal as “free” and 
Destroy FX (among others) 
as “donationware.” On the 
Disc and on page 8 you list 
Crystal as “donationware” 
and Destroy FX as 
“freeware.” Please clarify 

the licensing.—John Dalbec
Sorry about that. Destroy FX 
plug-ins are free, although 
PayPal donations are 
accepted (http://destroyfx
.smartelectronix.com/donate
.html). According to www
.greenoak.com/crystal, Crystal 
is free; its developer does, 
however, suggest that users 
who want to donate send 
contributions to the Clairemont 
Senior Friendship Center in San 
Diego. Do I get a donation for 
tracking that info down?—Max

SPAM OF THE MONTH
Hello I acquainted through 
the Internet for the fi rst time. 
Therefore I have decided 
to write to you. My name is 
Teona. I am from city of Kazan, 
which located Russia. I have 
fi nished local University. Now 
I work in branch of a biggest 
Moscow’s Firm. I am cheerful 
kind and very sociable. I 
am very Economic also are 
capable to be prepared well. I 
do not know why the Russian 
men Do not notice it. I also 
could not fi nd love in Russia. 
I never was Married and I 
have no any children. I am 
lonely. Now I want to fi nd Love 
through the Internet. I am very 
estimate qualities People and 
their attitudes. If you want to 
fi nd out about me more and to 
Continue our dialogue, I will 
wait your letter.—Teona
Oh, baby. Your qualities are 
soooooo estimate.—Max

PANORAMA-PALOOZA

I was out taking pictures today and decided to try a 
panorama to get the bigger picture—I got the idea from 
MacAddict (“Free Your Inner Artist” Aug/06, p18). This is the 
view from St. Augustine Cemetery overlooking Montpelier, 
VT. I started with 17 images and spent an hour stitching 
them together. I think it turned out pretty well.—Bill Peters
I agree! That’s quite a pretty cemetery—I bet people are just 
dying to get in there. (Sorry; I couldn’t resist.)—Max

He’s probably remixing “Cat 
Scratch Fever.”

Send email entries to: contest@macaddict.com with the subject: iLuv Contest
(Don’t forget to include your address information!)
Send snail-mail entries to: iLuv Contest, MacAddict magazine, 
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080.
Deadline for entry: October 31, 2006.
Contest results will appear in our Feb/07 issue.

Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent 
originality, and 33 percent creativity. All entries must be received no later than October 31, 2006, with the winner 
announced around February 2007. By entering this contest, you agree that Future US, Inc. may use your name, 
likeness, and Web site for promotional purposes without further payment. All prizes will be awarded, and no 
minimum number of entries is required. If two or more people enter identical winning captions, the entry received 
fi rst will be awarded the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. 
Future US, Inc. is not responsible for damages or expenses the winners might incur as a result of this contest or 
the receipt of a prize, and winners are responsible for income taxes based on the value of the prize received. A list 
of winners may also be obtained by sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict 
Contest, 4000 Shoreline Court, Suite 400, South San Francisco, CA 94080. This contest is limited to residents of 
the United States. No purchase necessary; void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited 
by law.

Entry Form

WIN!

WRITE TO US!
Mac Addict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080 
or letters@macaddict .com

FOR CD PROBLEMS: 
go to www.futureus-inc.com

FOR SUBSCRIPTION QUERIES: 
call (toll-free) 888-771-6222

Volume 11, Issue 10
MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San 
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand 
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90, 
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the 
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box 
5126, Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, PC Gamer, Official Xbox Magazine, PSM, Guitar 
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal,
Snowboard Trade News, Revolver, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc. All rights reserved. 
Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products covered in 
MacAddict. Ride-Along enclosure in the following edition(s): B, C, C1, C2. PRODUCED IN THE UNITED STATES OF AMERICA. 
Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3

Write a caption 
for this picture.



80 SHUT DOWN
don’t let the back page hit you on the way out

  

A fter the keynote, the presentations, and hour after hour of hands-on tech labs, the 
übergeeks attending Apple’s Worldwide Developers Conference can’t wait to get 

their hands on something else: booze! And lots of it. Watch—if you dare—as the pale 
and pasty page-niners rip off their pocket protectors and 
cut loose, WWDC style.

WWDC
EDITION!

U
N
C
E
N
S
O
R
E
D
!

NERDS! GEARHEADS! CODERS!

October 200680
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